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Intel Skylake: All the speeds, 
feeds, and prices, and which 
one is right for you
Take a deep dive into Skylake’s 48 new CPUs, from energy-sipping mobile 
versions to beefy overclockers.

Tech and trends that will affect you today and beyond. NEWS

BY MARK HACHMAN



rying to figure out which sixth-generation Intel Core chip to 
buy in Intel’s Skylake family is like going to a preseason 
baseball or football game: There are numbers everywhere. 

Somewhere in the crowd are the superstars. But which ones?
We can’t test everything at PCWorld, but what we can do is provide a 

handy scorecard of the Skylake chips Intel launched at the IFA show in 
Berlin in early September. We’ve already told you why Skylake is a 
“sixth-generation CPU,” (go.pcworld.com/6thgencpu) what you need 
to know about Skylake, and even an early review of the i7-6700K (go.
pcworld.com/i7-6700k), one of the high-end desktop Skylake chips 
Intel will ship this fall. (For a general overview of Intel’s Skylake 
announcements, please see our main Skylake launch story (go.
pcworld.com/skylakecpu).

Here’s what you need to know about Skylake in a nutshell: The prices 
Intel has published appear 
to be about the same that 
it’s charging for its 
Broadwell chips—meaning 
that, from a price 
perspective, it’s a 
no-brainer to bypass 
Broadwell or Haswell for 
Skylake. But there’s a 
catch for desktop users: 
Skylake uses a new 
motherboard socket and memory, meaning that you’ll practically have 
to invest wholesale in a new system.

For laptop users Skylake does hit a new, lower, power threshold, so 
your portable’s battery should theoretically last a bit longer.

Intel announced five families of microprocessors at IFA: four for the 
Core family, as well as new Core m (yes, lowercase m) designations for 
the i3, i5, and i7. If you’re buying an Intel-based tablet, chances are it 
will include a Core Y-series chip. Thin-and-light notebooks will use the 
U-series chips. So-called “ultimate mobile” systems and performance 

T

The prices Intel has published 
appear to be about the same that 
it’s charging for its Broadwell 
chips—meaning that, from a price 
perspective, it’s a no-brainer to 
bypass Broadwell or Haswell for 
Skylake. But there’s a catch.





workstations will include the H-series chips, while the S-series chips 
will be included in both performance and value desktops, all-in-ones, 
and mini PCs.

A quick guide to the charts
We’ve included Intel’s processor charts throughout this story. Just like 
baseball statistics have evolved from batting average and ERA to WAR 
and OPS+, so have the metrics Intel uses to describe its processors. 
Price, clock speed, and the number of cores still remain as the primary 
metrics. Just note that the price Intel is quoting is for a bulk order in 
lots of 1,000. You’ll typically pay more for an individual chip initially.

(And while this may sound obvious, here’s a handy tip: Almost all 

Intel’s high-
end Skylake 
desktop lineup.

6th Gen Intel® Core™ Desktop Processor SKU Detail (91W)
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sixth-generation Core chips—aka the “Skylake” family—use a 6 as the 
first number of their product name, such as the i5-6500T.)

Modern operating systems like Windows 10 are better at divvying up 
tasks among the multiple cores that most processors include, so a 
greater number of cores and threads generally translates into 
improved performance. If necessary, those cores can kick into “turbo 
mode,” temporarily overclocking themselves to complete a task 
quickly. Core i3 chips lack this capability.

Consumers shouldn’t have to worry about Intel’s Stable Image 
Platform (SIPP) or Small Business Advantage (SBA) technologies. Ditto 
for Intel vPro. You might want to consider buying a chip with Intel TXT 
technology built in, however; that’s the Trusted eXecution 
Environment which seems to be at the heart of new Windows 
technologies such as Windows Hello (go.pcworld.com/w10helloworks) 
and Passport. Virtually all of the new Skylake chips include 
virtualization technology—a geeky way to test out a future version of 
Windows 10, but essential if you want to run Android apps on your PC 
(go.pcworld.com/pcandroidapps). 

Note: Not everything Intel announced at IFA will be immediately available. 
(If the price is listed as “To Be Determined,” (TBD) Intel will ship it at a later 
date—either during the fourth quarter or in early 2016.)

6th Gen Intel® Core™ Desktop Processor SKU Detail (35W)6th Gen Intel® Core™ Desktop Processor SKU Detail (35W)





High-end desktops: the S series
While Intel hasn’t announced any of its high-end “Extreme Edition” 
parts yet, the first thing that should strike you is the overall reduction 
in power, although it may not seem apparent initially.

An Intel 4GHz Core i7-4790K Haswell CPU, for example, is rated to 
dissipate 88 watts of heat. Its direct replacement is the 4GHz Core 
i7-6700K, which has a “TDP” rating of 91 watts. Both of these CPUs are 
designed for enthusiasts who will overclock. 

The better comparison would be the 3.6GHz Core i7-4790 chip that 
doesn’t overclock. Even with its lower clock speeds, it maintains the 
same TDP rating of 84 watts. For Skylake, the 3.4GHz Core i7-6700 
that can’t be overclocked has a TDP rating of 65 watts. To be fair to 
Haswell, there was a Core i7-4790S version with the same TDP rating 
as its Skylake counterpart, but the clocks drop even lower, to 3.2GHz.

Even though Skylake represents a processor redesign and not a 
process shrink—where most of the power reduction takes place—
Skylake should consume less power than a similar Haswell chip.

The other thing to notice is that, at least for now, all of the desktop 
chips that Intel has announced have at most four cores and eight 
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threads. Intel’s Core i7-5820K and higher “Haswell-E” chips that use 
larger sockets and don’t contain integrated graphics all contain 6 
cores and 12 threads. It’s not clear whether Intel plans to add similar 
parts in the future, or leave a 4-core/8-thread as the high end in the 
smaller socket. 

What does seem clear, though, is that are only single Core i5 and 
Core i7 unlocked “K” versions of the Skylake parts; it’s virtually assured 
that more will be added over time.

From a graphics perspective, the desktop chips are virtually identical: 
They all use the new Intel HD Graphics 530 core. Just be aware that some 
of the slower chips—the i5-6400, specifically—have their graphics cores 

Intel’s mobile 
Skylake chips 
include the 
intriguing 
mobile Xeon 
and an over-
clockable Core i7.
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clocked lower under load. Still to come are Intel’s Skylake chips using 
em bedded DRAM, which should greatly increase graphics performance.

The desktop Pentium chips
Intel resuscitated the Pentium brand awhile back, a seemingly odd 
throwback to the days not too long past when gamers had to tweak 
HIMEM.SYS and other system files to allow their PCs to work. Today, an 
Intel Pentium is synonymous with low cost. Intel will also launch 
Celeron versions of Skylake in the future, at an even cheaper price.

You can see that buying a Pentium isn’t that bad of a deal for basic 
computing. Here’s the interesting thing, though: Because there’s no 
Turbo Boost self-overclocking mode, the Pentiums are actually 
clocked faster than some of their Core cousins. Couple that with a 
pared-down cache to save cost, and the result is a cheap chip that’s 
going to run at full speed fairly aggressively. The only caveat is the lack 
of Hyper-Threading, which is Intel’s virtual CPU technology that makes 
two CPU cores act like four. Depending on what you do though, you 
may not feel it.

And no, cheap gamers, we asked: Intel said none of the new Skylake 
Pentiums support overclocking, like it did with the “Anniversary 
Edition” Pentium G3258. 

Intel can’t shave as much power in the mobile space, where the 
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maximum thermal power of a Broadwell chip, 47 watts, is nearly 
identical to the 45 watts that a mobile Skylake processor consumes. 
Here, though, Intel is focusing on the time in which the chip needs to 
be powered up. Intel’s Skylake-specific Speed Shift feature reduces 
the time in which a chip needs to shift from a high-power to a low-
power sleep state to as little as 1ms, versus 30ms or so before. This 
sounds like a tiny detail, but when the chip is constantly shifting from 
a full-power “busy” state to a sleep state, it’s a big deal.

One of the oddities of the new mobile Skylake line is the new mobile 
Xeon “server” processor, designed for true mobile workstations. Intel 
has already begun shipping the chip—at the SigGRAPH show in 
August, Lenovo announced the P50 and P70 workstations, including 
the chip as well as peripheral enhancements like Thunderbolt 3.0, 

All of the  
15W Skylake 
variants prove 
that Intel 
certainly 
believes in  
the ultrabook 
market.
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based on the new Intel Alpine Ridge controller.
Gamers, though, may want to think about the Core i7-6820HK. Why? 

Because it carries that magical K suffix, meaning that it’s over-
clockable. Yes, an overclockable mobile chip! At IDF, Intel executives 
said we’d be seeing laptops with an easy-peasy, one-touch 
overclocking mode by way of a “turbo” button. 

In general, though, Intel’s mobile chips show a definite progression 
down the performance curve: The more expensive Core i7s boast 
larger cache, robust Turbo Modes, and a faster maximum graphics 
clock speed. All of these factors decline as the processors step down 
into the Core i5 and Core i3 range. 

Be aware that Intel also has two other lineups of Core i7/i5/i3 for 
ultrabook PCs consuming 28 and 15 watts. In general, you should 
expect lower performance but longer battery life with these chips. 
Because laptops in general are getting thinner by the day, it might not 
be totally clear whether you’re buying an “ultrabook” or just a thin 
laptop.

These lower-power chips differ from the more robust 45-watt  
variants in two key ways: The number of cores are significantly  
reduced. Also, Intel has included what appears to be a down-clocked 

Just 4.5 watts! 
That’s impressive.
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mode, for activities like simply displaying a webpage, for example,  
that require less exertion from a chip.

You’ll also notice two graphics variations: a slightly underclocked 
version of the HD Graphics included on the 45-watt chips, as well as an 
entirely different Iris 
Graphics architecture. The 
Iris Graphics brand has 
generally been used for 
Intel’s premium graphics 
product, which means the 
lower-power products 
may actually outperform 
the chips with more cores. 
(But note the “TBD” designation in the pricing column. Iris Graphics is 
coming later, and Intel’s not saying when.)

If you’re wondering why, it’s likely because higher-wattage quad-
cores are almost always coupled with discrete graphics for more 
performance. The lower-power U-series chips almost always go it 
alone with integrated graphics. Still to come will be the Iris Pro version, 
using its own dedicated 64MB or 128MB eDRAM frame buffer.

One has to wonder whether, over time, Intel might add a 4-core/8-
thread version of the 28W Core i7 chip, as a middle ground for gamers. 
Eventually, the PCI-SIG hopes to mainstream a technology called 
Oculink, which lets gamers tote around a low-power laptop by day and 
connect it to an external GPU for gaming after hours. 

The Core M (sorry, Core m) now has  
its own naming scheme
So-called two-in-one or hybrid devices occupy their own little niche: 
Sometimes they’re a tablet, and sometimes they’re a notebook. Now, 
with Intel’s new Skylake Core m chips, you’ll have a better sense of 
what’s what. 

What surprises me most, however, is the price Intel’s charging—
almost $300 a pop in most cases. That means the Skylake Core m 

You’ll also notice two graphics 
variations: a slightly underclocked 
version of the HD Graphics 
included on the 45-watt chips, as 
well as an entirely different Iris 
Graphics architecture. 





definitely won’t be appearing in devices that will compete with 
Android tablets. For the price of a Core m, you’d be able to buy a 
decent Android tablet all by itself. 

The Core m, however, features both upclocked and downclocked 
modes, allowing the tablet to rev up when needed, then clock down 
when not. (The Core m3 can also enter Turbo Mode, unlike the Core i3.)

While the Intel HD Graphics 515 chip is part of the Skylake family, it’s 
pretty bare-bones in terms of performance. Still, the selling point is 
power: Core m chips run at just 4.5 watts, and Intel believes you’ll get 
up to ten hours of battery life with a Core m tablet. 

Know your chips to make the best purchase
If you’ve read this far, you should have a better idea of what 
distinguishes which Intel Skylake chip from another. It’s useful 
information, because eventually, you’re going to see an ad or a sign 
advertising a “Core i7” computer on heavy discount, and you’re going 
to be tempted. You should be able to figure out whether the vendor is 
selling an older Broadwell chip, or perhaps a low-end Core i3 that isn’t 
what you’ll want.

Remember, too, that Intel’s Skylake is more than just a chip—it’s also 
a collection of technologies designed to revamp the PC. 







BY MARK HACHMAN

AFTER LAUNCHING A LARGER iPhone 5 Plus last year that mimicked 
phablets like the Lumia 1520, Apple has taken another page from 
Microsoft’s playbook with the Apple iPad Pro—which now includes a 
Surface-like keyboard and stylus.

Apple’s new iPad Pro—available from $799 to $1079, with storage 
ranging from 32GB to 128GB—will be available this November, a bit 

Surface Pro 3 vs. iPad Pro: 
What Apple’s copied,  
what it does better
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after the reported introduction of the Surface Pro 4. But for right now, 
the comparisons between it and the Surface Pro 3 are undeniable.

Before we dive into the hardware specs, let’s make one key software 
difference clear: The iPad Pro still runs iOS, instead of the full Windows 
desktop OS you can use on a Surface Pro. For many power users, that’s 
the difference between an accessory and an essential piece of 
equipment. 

On the hardware side, two elements—the so-called Smart Keyboard 
and the Apple Pencil—are going to have Microsoft Surface fans 
whooping with glee. (They will be sold separately, as is the case with 
the Surface Pro 3’s accessories.)

Because the iPad still lacks a kickstand, the Smart Keyboard copies 
the foldover “origami” keyboard of Amazon’s tablets. Like the Surface, 
it connects to the tablet through three metal bumps, which transmit 
data as well as power. Unlike Microsoft’s Type Cover, the keyboard lies 
flat on the tabletop; and, like the Touch Cover, it’s made of fabric as 
well—an improvement on typing directly on glass, but probably not 
much. The keyboard will be available for $169, in November.

And then there’s the Apple Pencil, a $99 stylus that’s really long—

Doesn’t this 
Apple Smart 
Keyboard look 
familiar?



about the length of an ordinary #2 pencil, it appears. It’s far longer 
than the stylus that ships with the Surface Pro 3 tablets, and it 
appears to lack a loop or even a docking port to connect to the tablet. 
It does, however, include a Lightning connector for charging.

Apple’s Schiller claimed that the iPad Pro and the new Pencil worked 
together to give the impression of nearly latency-free inking, 
supporting different levels of inking pressure. It has the precision to 
“touch a single pixel,” Schiller claimed. 

To support his claims, Schiller brought on stage executives from 
Microsoft—to show off Office for the iPad—and Adobe, which 
demonstrated apps like Adobe Fix, allowing graphic artists to 
manipulate images digitally on the iPad.

The Apple 
Pencil in 
action.
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Where the iPad Pro does better
In other ways, the iPad Pro jumps ahead of the Surface Pro 3. For 
starters it’s slightly larger, at 12.9 inches versus 12 inches. Apple hasn’t 
said how much memory is inside it, but Apple senior vice president of 
product marketing Phil Schiller said that the tablet includes a more 
powerful 64-bit A9X chip that’s faster than 80 percent of the PCs 
shipped in the last 12 months, and 90 percent more powerful, 
graphically.

The display boasts a higher resolution than the Surface Pro 3 as well: 
2732 x 2048 pixels versus the 2160 x 1440 display offered by the 
Surface Pro 3. The battery life is a tad higher: 10 hours, versus 9 hours 
for the Surface Pro 3. Apple even showed off multitasking, dividing the 
screen between two different windows that could run different tasks.

For now, the iPad Pro’s hardware specs are arguably a tad superior to 
the Surface Pro 3’s. But while Apple may claim to have “reinvented” 
the idea of a productivity tablet with the iPad Pro, Surface owners 
know where Apple found its biggest ideas. We expect Microsoft to 
one-up Apple yet again with the Surface Pro 4.   

Oh boy, 
multitasking! 
But not quite 
in…windows.







BY BLAIR HANLEY FRANK

IN A SURPRISE MOVE, Microsoft sent a pair of representatives to Apple’s 
big press event in San Francisco early in September to demonstrate new 
features in Office for iOS that are tailored for the new iPad Pro. 

Kirk Koenigsbauer, Microsoft’s corporate vice president of Office 365 
client applications, came on stage at the Bill Graham Civic Auditorium  

Microsoft unveils new  
Office for iPad features  
on Apple’s stage
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to show new changes to the company’s suite of apps for Apple’s 
tablet, including the ability to draw freehand shapes on a Word or 
PowerPoint document, and then get them translated into shapes like 
arrows or circles. 

It’s designed to take advantage of Apple’s new Pencil stylus for the 
iPad Pro, a $99 accessory the company announced just ahead of 
Koenigsbauer’s appearance on stage. Users can also draw annotations 
on documents, and have those annotations sync across Office apps on 
iOS and other platforms. Microsoft didn’t say whether those inking 
features will require the iPad Pro and Pencil, or if they’ll also be 
available to other iPad users. 

In addition, the apps can take advantage of the new iPad 
multitasking features in iOS 9 to let users copy and paste content 





across different Office apps 
running side by side. That 
means users can take a chart 
from an Excel spreadsheet 
that they’re looking at on 
the right-hand side of an 
iPad Pro or iPad Air 2’s 
screen, and copy it to a Word 
document that’s taking up 
the left half of the device’s 
screen real estate. 

Having Office on the iPad 
Pro should help Apple attract 
the interest of enterprise 
users who might consider 
purchasing its new tablet for 
use in the workplace. Apple 
is competing against 
Microsoft in that arena, 
partnering with IBM and 
Cisco to turn iPads into 
compelling business devices. 
Meanwhile, Dell, HP, and 
others recently agreed to 
sell Surface Pro tablets as part of their enterprise sales efforts. 

Interestingly, Apple didn’t show off its iWork productivity suite, 
which the company bundles with iOS devices. iWork’s Pages, Numbers, 
and Keynote apps compete directly with Word, Excel, and PowerPoint, 
though Apple doesn’t spend nearly as much time discussing and 
promoting them as Microsoft does with its Office suite.

When users search for information using the iPhone and iPad’s 
Intelligent Search feature in iOS 9, it will also pull up notes stored in 
Microsoft OneNote, and emails from Outlook alongside relevant 
content from the Web and other sources. 
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On top of all the Office for iPad news, Microsoft also announced new 
features for two of its Apple Watch apps. Users of the Outlook app for 
iPhone and Apple Watch will be able to view appointment data as one 
of the complications on a watch face, and scroll through past and 
future events by rotating the digital crown.

The Microsoft Translator app can also bring key translated phrases 
to a user’s watch face, and will adjust those phrases to match the loca-
tion and time of day. That way, it will show how to say “good morning” 
first thing in the day and “good afternoon” as time moves on.

Koenigsbauer’s appearance is another sign of Microsoft’s new 
strategy under CEO Satya Nadella. The company has put significant 
effort into building apps for platforms it doesn’t control, including 
versions of Office for iOS and Android. Cross-platform use even extends 
to Microsoft’s executives: Koenigsbauer was conspicuously wearing an 
Apple Watch on stage, rather than one of Microsoft’s Bands.

All of the updates that Microsoft announced at this Apple special 
event will be available when iOS 9 and watchOS 2 launch.  





BY JARED NEWMAN

WINDOWS 10 ADOPTION hasn’t caught up with Windows 8.1 yet, but 
it may be getting close.

According to AdDuplex, the split between Windows 8.1 and Windows 
10 devices is currently 61 percent for the former, and 39 percent for 
the latter. If you don’t count Windows RT devices such as Microsoft’s 
Surface tablets, the ratio is 58.8 percent for Windows 8.1 to 41.2 
percent for Windows 10. The data comes from 173 Windows Store 
that use AdDuplex for cross-promotional ads.

Granted, this is hardly a complete measure of Windows 10 usage, as 
AdDuplex isn’t even counting devices that run Windows 8.0 or earlier. 
As we know from other metrics firms, Windows 7 is still the dominant 

Windows 10 is catching up to 
Windows 8.1, report says





NEWS

version of Microsoft’s operating system, running on roughly half of all 
laptops, desktops, and tablets.

In last month’s market share data from NetMarketShare and 
StatCounter, Windows 10 was still far from overtaking even Windows 
8.1. NetMarketShare showed a 69-31 split between the older and 
newer operating systems, while StatCounter found a 73-27 split.

In terms of user numbers, Microsoft itself has said Windows 10 was 
installed on 75 million machines after four weeks. Thanks to the free 
upgrades Microsoft is offering to consumers running Windows 7 or 
higher, adoption has been faster than for any previous version of 
Windows.

Why this matters: AdDuplex’s data is useful in showing how quickly 
devices with the Windows Store are moving to Windows 10. As the 
balance tilts away from Windows 8.1, developers could have more 
incentive to update their apps with full Windows 10 support, or even 
create Universal Apps that can run across phones, tablets, laptop and 
desktop PCs, and game consoles. 





BY JARED NEWMAN

WHETHER YOU WANT Windows 10 or not, Microsoft says it may 
download the files to your PC regardless.

In a statement to the Inquirer, Microsoft confirmed that it 
automatically downloads Windows 10 installation files on eligible PCs, 
provided automatic updates are enabled through Windows Update. 
The download occurs even if users haven’t opted in through the 
Windows 10 reservation dialog.

“For individuals who have chosen to receive automatic updates 
through Windows Update, we help upgradable devices get ready for 
Windows 10 by downloading the files they’ll need if they decide to 

Didn’t ask for Windows 10? 
Your PC may have 
downloaded it anyway
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upgrade,” Microsoft told the Inquirer. “When the upgrade is ready, the 
customer will be prompted to install Windows 10 on the device.”

When reached for comment, Microsoft told PCWorld that the 
downloads occurred around the time of Windows 10’s July 29 launch.

Why this matters: Microsoft appears to have crossed a line in its zeal 
to move people onto its latest operating system. Several reports 
indicate that the Windows 10 files take up as 
much as 6GB of storage in a hidden folder, 
potentially hamstringing machines that 
don’t have much free space left. Even worse, 
users who have strict data caps could face 
hefty overage charges for a massive 
download that they didn’t even ask for.

Bye-bye bandwidth
PCWorld has also heard from several readers on this issue, including 
one whose data plan has been affected by the automatic download. 
The reader, who runs a small computer repair shop, did not reserve 
Windows 10, yet recently noticed 6GB missing from his main desktop.

Upon further investigation, the reader’s daughter—who lives in an 
area without wired Internet and relies on Verizon Wireless for 
connectivity—had also automatically downloaded the installation 
files. “They do not wish to upgrade at this time, as they prefer to stay 
with Windows 7,” the reader said. “But they’re four days into their 
wireless plan, and have used more than half of their allowance because 
of the Windows 10 download.”

The Inquirer also spoke to a reader who said Windows 10 tries to 
install itself every time the machine is booted. It’s unclear if this is 
typical behavior for those who haven’t opted into the upgrade.

This isn’t the only instance where Windows 10 has gotten users into 
trouble with data caps. By default, the system also uses peer-to-peer 
networking to distribute Windows 10 updates, potentially eating up 
bandwidth without users’ knowledge.

Microsoft appears to 
have crossed a line 
in its zeal to move 
people onto its latest 
operating system. 





What you can do
It’s worth noting that Windows Update provides users with a few 
auto-install options. Enabling the Important option for updates 
provides security and stability fixes, while the Recommended updates 
are meant to improve non-critical issues. There’s also a Microsoft 
Update option for other software such as Office. We’ve reached out to 
Microsoft to see which of these tiers enables the auto-download of 
Windows 10 files.

In the meantime, some users have reported success at removing the 
files and Windows 10 update prompts by entering the following into 
the command prompt as an administrator:

WUSA /UNINSTALL /KB:3035583code>

This should at least remove Windows 10’s update notifications (go.
pcworld.com/w10updateno), but we haven’t confirmed whether it 
removes the installation files and prevents further downloads.  
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BY IAN PAUL

ALL THE BIG NEWS from IFA Berlin 2015 is in and, wow, if this eye-
grabbing lineup doesn’t help the PC industry make it rain this holiday 
season, what will?

As a follow-up to the Windows 10 introduction in July, we got details 
on Intel’s latest “Skylake” Core chips, some amazing gaming laptops, a 
modular PC, a new Compute Stick design, wireless charging for your 
laptop, and…oh, geez, just check it out—and prepare for a serious 
case of tech envy. 

The 10 coolest, fantastical, 
and most powerful PC 
reveals of IFA 2015
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1. Skylake’s full launch
Intel’s “Skylake” sixth-generation 

Core processors (go.pcworld.com/
skylake10) are the key to everything that 
was announced at IFA Berlin. It’s kind of 
like the second act for PCs following 
Microsoft’s introduction of Windows 10. 
Combined, the WinTel alliance will deliver 
powerhouse PCs rocking 4K displays, 
infrared cameras for facial recognition, and gesture-based computing. 
On top of that, Skylake packs the usual boost in speed and reduction 
in power consumption typical of new Intel processors.

For all the hard details, see our story on page 8 and the Skylake 
cheat sheets, which include data on everything from new 91-watt 
desktop processors down to the 4.5W Core m (formerly Core M) chips 
and everything in between. We’ve already reviewed the high-end 
desktop chips (go.pcworld.com/skylakechips). 

2. Asus’s liquid-cooled laptop
Laptop? Yeah, right. 

You’ll need a sturdy table for 
this monster, at least when it’s 
docked to that “gigantic 
bulbous butt.” Asus’s GX700 
(go.pcworld.com/gx700)
gaming notebook comes with 
an overclocked quad-core 
Skylake mobile “K” series 
processor and a 17-inch 4K (3840-by-2160) display, plus it’s rocking an 
as-yet-unreleased Nvidia mobile GPU.

Asus is mostly hush-hush about the laptop, but it appears the water 
cooling rig is that growth in the back. The clamshell can undock from 
it for a more portable PC. Hook it up at home, however, and you’ve got 
water keeping your components cool so they don’t melt under the 







stress of Witcher 3 on Ultra settings.
No pricing info yet, but the GX700 should head our way before the 

end of the year.

3. Acer Predator gaming notebooks
Acer introduced two new gaming notebooks  

at IFA: the Predator 15 and Predator 17 (go.pcworld.com/
predator15). Both laptops pack a Skylake Core i7-6700HQ 
chip, GTX 980 graphics, up to 32GB of RAM, and a 512GB 
PCIe SSD. The Predator 15 has a 15.6-inch display 
with your choice of 1080p or 4K (3840-
by-2160) resolution. Acer decided not to 
follow Asus’ lead by packing 4K into a 
17-inch screen, opting for 1080p only on the 
Predator 17.

Acer has also added some neat gamer-centric features, such as a 
Cooler Master fan module you can slap into the optical drive bay for 
extra cooling during intense gaming sessions. The Predator gaming 
rigs are priced at $1,500 and $1,600 for the 15- and 17-inch models, 
respectively, and roll out in November.

4. Acer Revo Build
We’ve already seen a Lego-inspired modular computer (go.

pcworld.com/legopc), now Acer is coming out with its own stackable 
PC that snaps together. The Acer Revo Build mini PC (go.pcworld.
com/acerrevo) uses pogo pins and magnetic alignment to join 
modules together.

The base unit is contained in a 1-liter chassis with a 4.92-by-4.92-
inch footprint. Modules—which Acer 
calls “blocks”—include an external hard 
drive in 500GB or 1TB sizes, a wireless 
charger, and an audio module with 
speakers and microphone. Acer promises 
more blocks to come.







U.S. pricing and availability for the Revo Build were not announced. In 
fact, Acer’s not even sure it will get here. Nevertheless, it’s a cool 
concept, and there’s always Amazon and eBay if you really want this PC.

5. Acer’s Windows 10 PC Phone
Acer is the first company to take up Microsoft’s challenge to 

use Windows 10 Mobile’s Continuum feature to transform your phone 
into an ad hoc PC, but it won’t be the last. Acer’s slick Jade Primo (go.
pcworld.com/jadeprimo) packs a 5.5-inch AMOLED display, a 
21-megapixel rear-facing camera with dual flash, and an 8MP front-
facing camera, all supported by Qualcomm’s Snapdragon 808 

processor. The Primo will also have 
an optional dock to connect to an 
external monitor over HDMI for 
that PC-like experience powered by 
your phone and Windows 10’s 
universal apps (go.pcworld.com/
universalapps).

True, there have been a few 
phones to try this trick in the past, 

such as the Motorola Atrix. Continuum’s a highlight feature for 
Windows 10 Mobile, though, so expect to see at least a few more “PC 
phones” in the next year—including new flagship Lumias (go.pcworld.
com/lumias) from Microsoft itself.

6. Lenovo Miixes it up with Surface
It took the Microsoft Surface three generations to 

achieve its original aims (go.pcworld.com/surfacevision), but 
there’s no question it was a solid concept from day one. 
Lenovo appears to agree, as it’s…er…borrowing some 
Surface concepts for the Ideapad Miix 700 (go.
pcworld.com/lenovomiix) rolling out in 
November, with prices starting at $700.

This 12-inch, 2-in-1 tablet can hold up 
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to a Skylake Core i7 processor, maxes out at 8GB of RAM, and offers a 
256GB SSD, an LTE upgrade, and an optional Intel RealSense 3D 
camera. There’s also a Lenovo Keyboard Folio accessory to convert the 
tablet to a laptop.

The Miix 700 was only one small part of Lenovo’s avalanche of 
announcements. From the Ideacentre AIO 700 to Skylake-toting 
ThinkPad Yoga convertibles, check out the rest of Lenovo’s Windows 
PC blitz at IFA (go.pcworld.com/ifa15lenovo).

7. Intel’s Core m Compute Stick
Forget about pipsqueak Atom processors. 

Intel’s next Compute Stick (go.pcworld.com/
computerstick) design—which turns your HDTV 
into a PC via HDMI—will come rocking a Skylake-
based Core m processor.

The change is thanks to Skylake’s extreme 
scalability, which allows it to power 90W desktop 
processors all the way down to the puny 4.5W Core 
m. Even better, this Compute Stick will be able to display 4K video. Talk 
about a pocket rocket.

8. Asus’s audacious home router
Google isn’t the only company rethinking the router (go.

pcworld.com/routerrethink). At IFA, Asus introduced the RT-AC5300U 
(go.pcworld.com/rtac5300u), a powerful 4x4 home router that can 

broadcast two 5GHz 802.11ac networks 
with TCP throughput maxing out at 
2165Mbps each. There’s also a single 
2.4GHz 802.11n network that gets 
1000Mbps of TCP throughput. Simply put, 
it looks like this will be the most powerful 
consumer router ever when it launches 
later this year.

When you’re not connecting to the 





Internet, this claw-shaped monster also doubles as a coaster for your 
Klingon blood wine. Well, not really, but it sure looks like it could. Kaplah!

9. Intel goes wireless
Intel’s push for a cable-free future for 

the PC continued at IFA with a new way to 
wirelessly charge your laptop (go.pcworld.com/
wirelesscharge) in 2016. The system doesn’t 
have a name yet, but it’s the result of merging 
standards from the Alliance for Wireless Power 
and the Power Matters Alliance. When it hits 
the market, Intel aims for it to deliver up to 20 
watts of power to your device—double the 
amount of power delivered by most current wall adapters for tablets.

Intel also used IFA to show off WiGig, a wireless gigabit data link for 
connecting monitors, hard drives, and other peripherals. WiGig is 
currently supported by Dell and Hewlett-Packard.

10. Toshiba’s impressive Satellite
Toshiba held nothing back in the convertible Satellite Radius 

12 (go.pcworld.com/satelliteradius12) laptop. This powerful 12.5-inch 
road warrior could give Lenovo’s X series a run for its money—at least on 
the spec sheet.

The top-notch model of this PC includes an IPS touchscreen display 
with 3840-by-2160 4K resolution, Technicolor-certified color accuracy, 
an infrared camera for use with Windows Hello (go.pcworld.com/

helloworks), and, of course, a 
Skylake processor. That’s basically 
everything you could ask for in a 
Windows 10 laptop.

Toshiba hasn’t revealed pricing yet, 
but look for the Radius 12 to roll out 
before the end of the year.  
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BY MARTYN WILLIAMS

ENGINEERS AT XEROX PARC have developed a chip that will self-
destruct upon command, providing a potentially revolutionary tool 
for high-security applications.

The chip, developed as part of DARPA’s vanishing programmable 
resources project, could be used to store data such as encryption keys 
and, on command, shatter into thousands of pieces so small, 
reconstruction is impossible. (See the demo in the video above.)

Xerox PARC’s new chip will 
self destruct in 10 seconds

Watch the  
video at

go.pcworld. 
com/parc-chip
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It was demonstrated at DARPA’s Wait, What? event in St. Louis, 
Missouri, on September 10.

“The applications we are interested in are data security and things 
like that,” said Gregory Whiting, a senior scientist at PARC in Palo Alto, 
California. “We really wanted to come up with a system that was very 
rapid and compatible with commercial electronics.”

The result is a chip based on Gorilla Glass, the Corning-produced 
tough glass used in the displays of numerous smartphones.

“We take the glass and we ion-exchange temper it to build in stress,” 
said Whiting. “What you get is glass that, because it’s heavily stressed, 
breaks it fragments into tiny little pieces.”

In a demonstration on Thursday, the glass was stressed to breaking 
point by heat. When a circuit was switched on, a small resistor heated 
up and the glass shattered into thousands of pieces. Even after it broke 
up, stress remained in the fragments and they continued breaking into 
even smaller pieces for tens of seconds afterward.

The chip presents an exciting prospect in applications such as 
computer security. If a chip fabricated on glass was used to store an 
encryption key, the destruction of the chip could assure complete 

A chip fabricated 
on a glass sub-
strate shortly 
before destruc-
tion during a 
demonstration at 
DARPA’s Wait, 
What? confer-
ence in St. Louis, 
Missouri, on Sept. 
10, 2015.





destruction of the key in an instant—perhaps as part of a routine 
process or when the key falls into the wrong hands.

During the demo in St. Louis, the self-destruct circuit was triggered 
by a photo-diode, which switched on the circuit when a bright light fell 
on it. In this occasion, the light was provided by a laser, but the trigger 
could be anything from a mechanical switch to a radio signal. 

Shards of glass is 
all that’s left of a 
self-destructing 
chip during a 
demonstration at 
DARPA’s Wait, 
What? confer-
ence in St. Louis, 
Missouri, on Sept. 
10, 2015.







BY IAN PAUL

IN DECEMBER 2014, Samsung rolled out a new type of mobile DRAM 
that would allow smartphones to carry up to 4GB of volatile memory. 
Less than a year later, Samsung says it’s getting ready to cram up to 
6GB of RAM into our handsets.

The increased RAM comes courtesy of Samsung’s mass production 
of 12 gigabit LPDDR4 (low power, double-data-rate 4) mobile DRAM. 
The new memory is being produced using Samsung’s 20-nanometer 
(nm) process.

Samsung says the new DRAM is 30 percent faster than the previous 
20nm-based 8Gb LPDDR4 and twice as fast as DDR4 DRAM for PCs. 

Samsung’s new RAM heralds 
the dawn of 6GB smartphones
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The new mobile memory means a single package can use two chips to 
carry 3GB of RAM or four chips for 6GB. This will not only result in 
premium smartphones packing more RAM, but smaller phones won’t 
have to skimp on memory due to size constraints.

It’s not clear when we’ll 
start to see smartphones 
packing the new RAM. 
Right now, most phones 
use 3GB, and Apple packs 
just 1GB of RAM into the 
iPhone 6 Plus. Whether we 
need more memory in our phones right now is unclear, but no doubt 
developers will make use of the added RAM over time.

Why this matters: Samsung sees a future for its LPDDR4 DRAM 
beyond the smartphone and tablet markets where it’s currently called 
for. In the coming years, the company hopes to see Ultrabooks, digital 
appliances, and even auto tech packing the new DRAM. For now, 
however, it’s all about increasing the memory capability of mobile 
devices to support multitasking and more-powerful apps. 

The new mobile memory means 
a single package can use two 
chips to carry 3GB of RAM or 
four chips for 6GB.





THERE’S NO DOUBT about it: Windows 10 is studded with 
data-tracking tidbits and hooks into all sorts of Microsoft 
online services. Handing over all that data has some tangible 
benefits, like Windows 10’s OneDrive integration and the 

Bing-powered brains behind the Cortana digital assistant, but not 
everyone is thrilled with the idea of an operating system that’s 
constantly looking over their digital shoulder.

Don’t fret. I’m here to show you how to get your PC and its data out 
of the cloud and back on silicona firma. (Yes, I did just make that up.)

This guide will show you how to disable Windows 10’s integration, as 
well as provide tips on what those features actually do. That way, you 
can decide whether you want to keep any of it active or just shut the 
door on it altogether.

CONSUMER 
WATCH

Make smart purchases,  
stay safe online.

Windows 10 shares a lot of data with Microsoft in order to 
create a seamless experience across devices. If you lean more 
toward privacy, here’s how to disable all of it.

BY IAN PAUL  

How to reclaim your 
privacy in Windows 10, 
piece by piece





Tip: If you’re using an ad blocker or an extension like the EFF’s 
Privacy Badger, you may have to turn it off for this site before you’ll 
see the option to turn off in-browser ad personalization. The site 
apparently has to set a cookie for this second option to work.

Advertising
One setting you should 
consider disabling is all the 
advertising integration in 
Windows 10. Some of this 
was also present in Windows 
8, but if you’re just learning 
about it now you might as 
well turn it off.

Personally, I don’t mind 
seeing ads on websites, 
because that’s what pays for 
most of the free content we see online. What 
I do mind is “ad personalization.” I don’t need 
ads that are supposedly tailored to my 
personal tastes, thanks to little cookie spies 
that follow my travels around the web. 
Generic ads targeted at a site or app’s most 
likely demographic are just fine by me, thanks.

Turning off personalized ads in Windows 10 
is a two-step process. First, go to Settings → 
Privacy → General and slide the option that 
reads “Let apps use my advertising ID for 
experience across apps (turning this off will reset your ID)” to Off. 
(We’ll come back to the Settings app later to deal with the rest of 
those privacy settings.)

Next, open your web browser and go to choice.microsoft.com/en-us/
opt-out. There, select the Off position for “Personalized ads wherever I 
use my Microsoft account” and “Personalized ads in this browser.”





Cortana
Microsoft’s built-in digital assistant is 
incredibly useful for quickly setting 
reminders, calendar events, and 
sending email, among many other 
things. The information it collects is 
very similar to what Google does with 
Google Now, which you may already be 
using on your Android device.

But if you’re just not into Cortana, 
turning it off is very simple. And if 
you’ve never used Cortana, then don’t 
worry about it! It’s already off.

For everyone else, click the Cortana 
icon in the Taskbar, and then click the 
notebook icon on the left-hand side of 
the pop-up panel. Select Settings from 
the list of options that appear.

Now, just slide the top option that 
reads “Cortana can give you suggestions, 
ideas, reminders, alerts, and more” to Off.

Once Cortana is gone, you’ll see a new option that says “Search 
online and include web results.” As its title suggests, this includes Bing 
results (go.pcworld.com/disablebing) when you search for things on 
your PC. You’ll have to decide whether you want that enabled.

At this time, it’s also a good idea to jump back into the Settings app’s 
privacy section. Open Settings and go to Privacy → Speech, Inking, And 
Typing. This is a setting that allows Cortana to gather all kinds of data 
about you to help it deliver services. Click the Stop Getting To Know 
Me button to end that. Note that this will delete collected data stored 
on your PC, and it also turns off dictation functionality.

Once that’s done, click the “Go to Bing and manage personal info for 
all your devices” option. This is where you can scrub any data that 
Microsoft has collected about you from the company’s servers. 





Clearing this data will affect the performance of Cortana and other 
personalization services across your devices and Microsoft services. 
You can read through this page to understand what you’re losing, or 
just jump to the bottom and click Clear.

Wi-Fi Sense and peer-to-peer
Now let’s handle two features of Windows 10 that are innovative, but 
also concerning to privacy-minded people.

The first is Wi-Fi Sense. This is turned on by default, but it doesn’t do 
anything unless you explicitly use it. Wi-Fi 
Sense lets you share access to password-
protected Wi-Fi routers. The passwords are 
shared silently in the background over 
encrypted connections. People with whom 
you share network access never see the 
actual passwords, and they cannot grant 
sharing permissions for their friends.

The idea is that if your friends or family 
come over to your house, they don’t have to 
ask for your password. Instead, anyone who 
uses a Windows 10 device and is a digital 
friend of yours is automatically logged in. 
This is arguably more secure than sharing 
your password—once a person knows your 
Wi-Fi password they can easily share it with 
others, after all.

To make sure Wi-Fi Sense is off and stays off, go to Settings → 
Network & Internet → Wi-Fi → Manage Wi-Fi Settings. Then slide the 
two options that say “Connect to suggested open hotspots” and 
“Connect to open networks shared by my contacts” to Off.

Moving on, Windows 10 shares system files and updates downloaded 
to your PC with others by default. This peer-to-peer networking 
feature turns you into what you might call an unwitting good 
Windows citizen by helping others get updates and system files faster. 
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In return, your PC also receives update bits via other people’s PCs. It’s 
like using a BitTorrent client, essentially.

If you don’t like the sound of that, go to Settings → Update & 
Security → Windows Update → Advanced Options → Choose How 
Updates Are Delivered. By default, the “Updates from more than one 
place” option is enabled and set to both local sources and other PCs on 
the Internet. You have two additional choices, however: You can 
distribute updates only to PCs on your local network, or shut off the 
P2P updates entirely and stick to using Microsoft’s servers alone.

If you want to shut off everything, just turn the slider on this screen 
to Off. If you want to share with PCs on your local network, leave the 
slider in the On position and select the radio button that says “PCs on 
my local network.” For more detailed instructions, check out our 
primer on stopping P2P Windows 10 updates (go.pcworld.com/
w10updateno).

OneDrive
If you’re not interested in storing your files on 
Microsoft’s cloud servers, you can turn off 
OneDrive so it stops bugging you to configure it.

Just click the upward-facing arrow in the 
system tray on the right-hand side of the Taskbar. 
Then right-click the OneDrive icon and select 
Settings.

In the new window that opens, uncheck “Start 
OneDrive automatically when I sign in to 
Windows.” You can also uncheck the other two 
boxes if they’re selected as well: “Let me use 
OneDrive to fetch any of my files on this PC,” and 
“Use Office to work on files with other people at the same time.”

Back to Settings
Woo! Let’s take a breather. Feeling good? We’ve got the most 
essential parts of our privacy lockdown finished. Ready for some 





more? It’s time to dive into all those other privacy options in the 
Settings app by going to Settings → Privacy.

This is really the core of Windows 10’s privacy controls, but most are 
not as critical as the other items we’ve covered. The exception would be 
the remaining items under Privacy → General. Here you’ll want to turn off 
“Send Microsoft info about how I write to help us improve typing and 
writing in the future.” You may also want to shut off “Let websites 
provide locally relevant content by accessing my language list.”

After taking care of the settings under General, what you’ll mostly 
see in the remaining sections are methods for apps to access your data.

Each panel is pretty self-explanatory.
The Location section lets you control whether apps can use your 

location to deliver services like weather forecasts and local news. 
Location is a little unusual, because it can be set both on a per-device 
or per-user basis. To turn off location for the whole PC, click the 
Change button. To turn it off for only the logged-in user, turn the 
Location slider to Off.

You can also control location settings on a per-app basis by scrolling 
down to “Choose apps that can use your location.”

After location is taken care of, the rest of the settings follow a similar 
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format, allowing you to turn off access to things like your camera, 
microphone, contacts, and calendar on a systemwide or per-app basis. 
Just be careful not to let your privacy zeal impact truly useful features. 
The Mail app has reasonable justification for accessing your contacts, 
for example.

Microsoft Edge
Even if you use Microsoft’s fancy new browser, you may want to 
disable some features—like Cortana integration and typing 
prediction—if you don’t want to send any data back to Microsoft.

Open Edge and click on the menu icon in the far right corner (three 
horizontal dots). Go to Settings → View Advanced Settings. Here you 
have the option to turn off Adobe Flash—stop those Flash cookies!—
and under Privacy And Services you can decide to switch off a number 
of settings.

> “Offer To Save Passwords and Save Form Entries are both on by 

Microsoft 
Edge’s 
Advanced 
options.
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default. They are handy features though. Your call!
> “Have Cortana assist me in Microsoft Edge” lets Cortana work 

inside the browser. If you’ve already switched off Cortana, you 
definitely don’t want this feature on.

> “Show search suggestions as I type” uses Microsoft’s web-powered 
prediction service to guess what you’re searching for and fill it in 
automatically. Chrome and the standard version of Google search 
offer something similar, so you may already appreciate this 
convenience elsewhere and not realize it.

> “Use page prediction to speed up 
browsing, improve reading, and make my 
overall experience better” is similar to 
search suggestions in that it sends your 
browsing history to Microsoft. The 
company says this feature “uses 
aggregated browsing history data to 
predict which pages you’re likely to 
browse to next, and then loads those pages in the background for a 
faster browsing experience.” If you don’t like the sound of that, turn it off.

> “Help protect me from malicious sites and downloads with 
SmartScreen filter” lets Microsoft block malicious sites and downloads 
from infecting your PC. This feature lets Microsoft download a list of 
bad-acting URLs to your PC so Edge can block those sites. With 
SmartScreen active, whenever you land on a malicious URL you will be 
redirected to a Microsoft webpage that will get some PC information 
and the URL of the page you visited. If you ask me, the SmartScreen 
filter is pretty benign and well worth keeping activated. 

For more information, check out Microsoft’s Edge privacy FAQ (go.
pcworld.com/edgefaq).

Control Panel SmartScreen
There are three—count ‘em, three—SmartScreen filters in Windows 
10. The second one is in the Control Panel and stops you from 
installing potentially malicious desktop programs on your PC. It first 

If you use Microsoft Edge, 
you may want to disable 
some features if you don’t 
want to send any data 
back to Microsoft. 





appeared in Windows 8.
To offer this security feature, 

however, you have to share with 
Microsoft anonymized information 
about the programs you download 
and install.

Advanced users may just want to disable this feature, as it tends to 
be a nuisance. I’d strongly advise novice and intermediate users to 
leave SmartScreen as-is, however.

To disable it, right-click the Start menu button and select Control 
Panel from the context menu. Then, with the category view enabled, 
navigate to System And Security → Security And Maintenance. Select 
Change Windows SmartScreen Settings from the left-side pane.

In the window that opens, select the radio button next to “Don’t do 
anything (turn off Windows SmartScreen).”

Windows 10 and the web
Nope, we’re still not done. Two more sections to go—although the last 
one is only for the hard-core privacy types. First we want to deal with 
some odds and ends.
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Let’s start by examining the way Windows 10 syncs your personalized 
settings across devices, including your desktop background, web 
browser settings, saved passwords, language preferences, ease of 
access, and so-called “other Windows settings.”

The ability to sit down with any Windows 10 
device, log in with your Microsoft account, and 
have all your settings and preferences 
immediately show up is powerfully handy 
indeed. But if you’d rather not store all that 
information in Microsoft’s servers, the easiest 
thing to do here is just turn the Sync settings 
option found under Settings → Accounts → Sync Your Settings to Off. If 
you want to take a more fine-grain approach, you can drill down into the 
synced items under Individual Sync Settings.

Finally, let’s move on to the SmartScreen Filter. No, not the Edge one. 
Nope, not the one for downloading apps either. This is the Windows 
Store version we saw previously under Settings → Privacy → General.

Like its Edge counterpart, SmartScreen Filter checks the URLs of 
Windows Store apps and makes sure they’re not up to anything fishy. 
It’s a security measure that I’d argue is worth turning on. But if you’d 
rather not use it, go to Settings → Privacy → General and slide the 
option that says “Turn on SmartScreen Filter to check web content 
(URLs) that Windows Store apps use” to Off.

Local account
Finally, we’ve come to the last step: using Windows 10 with a local 
account. This is basically like putting a Windows 7 user account on 
your PC, with few ties to the cloud.

Navigate to Settings → Accounts → Your account name and then select 
“Sign in with a local account instead.” Then just follow the wizard to 
start using a local account on your PC—one that isn’t tied to your 
Microsoft account.

Using a local account will still let you access some built-in features in 
Windows 10, such as the Mail app, but you may also lose access to 

SmartScreen Filter 
checks the URLs of 
Windows Store apps to 
make sure they’re not 
up to anything fishy. 





others that require a Microsoft account, such as the Windows Store. You 
also can’t sync your settings to other Windows devices, but if privacy is 
your focus you probably turned that off in the previous step anyway.

So there you have it: all the privacy steps you need to take to keep 
Windows 10 firmly planted on the desktop and not the cloud. It’s 
admittedly a lot of work, but the good news is it only takes a few 
minutes to stay local once you know what you need to do.

But wait, there may be more?
This guide is only meant to turn off the user-facing cloud-connected 
facets of Windows 10. When this piece was being readied for 
publication, Ars Techica’s Peter Bright reported that there appears to 
be more “phoning home” going on behind the scenes with Windows 
10—even with all the previous privacy steps completed.

For those who want to dig into the nuts and bolts of Windows 10 
and its connection to Microsoft servers, we recommend you turn to 
Ars Technica’s report after you’ve taken the steps outlined here. 
Without taking these privacy measures first, dealing with what’s left 
won’t do much good. 



Think It Up is a new movement created to  
inspire students to pursue their passions 
through student-powered, teacher-led  
learning projects in classrooms across the 
country with support from Staples for Students. 

Students and teachers:  How can you  
spark great learning experiences in your  
classrooms today? 

Think It Up - because the work that students 
and teachers accomplish today will change our 
world tomorrow.

Join us at 

Nick Jonas, 
Think It Up Ambassador

Photo by Patrick EcclesineThink It Up™ is a program of the Entertainment Industry Foundation, a 501(c)(3) charitable organization.

Powered by





THE VAST MAJORITY of Android phones 
can be hacked by sending them a 
specially crafted multimedia message 
(MMS), a security researcher has found.

The scary exploit, which only requires 
knowing the victim’s phone number, was 
developed by Joshua Drake, vice 
president of platform research and 
exploitation at mobile security firm 
Zimperium.

Drake found multiple vulnerabilities in 
a core Android component called 
Stagefright that’s used to process, play, 
and record multimedia files. Some of the 
flaws allow for remote code execution and can be triggered when 
receiving an MMS message, downloading a specially crafted video file 
through the browser or opening a webpage with embedded 
multimedia content.

There are many potential attack vectors because whenever the 

BY LUCIAN CONSTANTIN

Most Android 
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simple MMS 
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Android OS receives media content from any source, it will run it 
through this framework, Drake said.

The library is not used just for media playback, but also to 
automatically generate thumbnails or to extract metadata from 
video and audio files such as length, height, width, frame rate, 
channels, and other similar information.

This means that users don’t necessarily have to execute malicious 
multimedia files in order for the vulnerabilities found by Drake to be 
exploited. The mere copying of such files on the file system is enough.

The researcher isn’t sure how many applications rely on Stagefright, 
but he believes that just about any app that handles media files on 
Android uses the component in 
one way or another.

The MMS attack vector is the 
scariest of all because it doesn’t 
require any interaction from the 
user; the phone just needs to 
receive a malicious message.

For example, the attacker could 
send the malicious MMS when the 
victim is sleeping and the phone’s ringer is silenced, Drake said. After 
exploitation the message can be deleted, so the victim will never even 
know that his phone was hacked, he said.

The researcher didn’t just find the vulnerabilities, but actually 
created the necessary patches and shared them with Google in April 
and early May. The company took the issues very seriously and applied 
the patches to its internal Android code base within 48 hours, he said.

That code gets shared in advance with device manufacturers that 
are in the Android partnership program, before it’s released publicly as 
part of the Android Open Source Project (AOSP).

Unfortunately, due to the generally slow pace of Android updates, 
over 95 percent of Android devices are still affected, Drake estimates.

Even among Google’s Nexus line of devices, which typically get 
patches faster than those from other manufacturers, only the Nexus 6 
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has received some of the fixes so far, the researcher said.
Android patches can take months to reach end-user devices through 

over-the-air updates. That’s because manufacturers have to first pull 
Google’s code into their own repositories, build new firmware versions 
for each of their devices, do testing, and then work with mobile 
carriers to distribute the updates. Devices older than 18 months 
generally stop receiving updates entirely, leaving them vulnerable to 
newly discovered issues indefinitely.

The vulnerabilities found by Drake affect devices running Android 
versions 2.2 and higher, which means that there are a huge number of 
devices that will probably never receive patches for them.

The researcher estimates that only around 20 to 50 percent of the 
Android devices that are in use today will end up getting patches for 
the issues he found. He noted that 50 percent is wishful thinking and 
that he would be amazed if that happened.

In an emailed statement, Google thanked Drake for his contribution 
and confirmed that patches have been provided to partners.

“Most Android devices, including all newer devices, have multiple 
technologies that are designed to make exploitation more difficult,” 
the company said. “Android devices also include an application 
sandbox designed to protect user data and other applications on the 
device.”

What attackers can do after they exploit the vulnerabilities found by 
Drake can vary from device to device. Their malicious code will be 
executed with the privileges of the Stagefright framework, which on 
some devices are higher than on others. In general the attackers will 
get access to the microphone, camera, and the external storage 
partition, but won’t be able to install applications or access their 
internal data.

That said, Drake estimates that on around 50 percent of the affected 
devices the framework runs with system privileges, making it easy to 
gain root access and therefore complete control of the device. On the 
rest of devices, attackers would need a separate privilege escalation 
vulnerability to gain full access.
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Since the patches for these flaws are not yet in AOSP, device 
manufacturers that are not Google partners don’t have access to 
them. It also means that third-party AOSP-based firmware like 
CyanogenMod is still likely vulnerable.

Drake shared the patches privately with some other affected parties, 
including Silent Circle and Mozilla.

Silent Circle included the fixes in version 1.1.7 of PrivatOS, the 
Android-based firmware it developed for its Blackphone privacy-
focused device.

Mozilla Firefox for Android, Windows and Mac, as well as Firefox OS 
were affected by the flaws because they used a forked version of 
Stagefright. Mozilla fixed the issues in Firefox 38, released in May. 





RESEARCHERS AT SECURITY 
company ESET have found a type 
of malware that changes an 
Android device’s PIN, the first of its 
kind in an ever-evolving landscape 
of ransomware attacks.

For most users, the only option to 
get rid of the malware is to reset 

BY JEREMY KIRK
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the phone to its factory settings, which unfortunately also deletes all 
the data on the device.

The malware calls itself “Porn Droid” and bills itself as a viewer for 
adult content. It has only been seen on third-party Android application 
marketplaces or forums for pirated software, wrote Lukas Stefanko, an 
ESET malware analyst.

But after it’s installed, users see a warning supposedly from the FBI 
that they’ve allegedly viewed “prohibited pornography.” It asks for a 
US$500 fine to be paid within three days.

To change the device’s PIN, Porn Droid needs administrator-level 
access to the phone.  Stefanko wrote that the malware uses a new 
method to obtain that high level of access.

When Porn Droid runs, it asks people to click a button to activate the 
viewer app. But beneath that window, and obscured by it, is another 
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button for setting device administer privileges.
“After clicking on the button, the user’s device is doomed,” Stefanko 

wrote. “The Trojan app has 
obtained administrator rights and 
now can lock the device. And even 
worse, it sets a new PIN for the 
lock screen.”

Other kinds of Android malware 
locked the screen by keeping the 
ransomware warning in the 
foreground using an infinite loop. 
But that could be remedied by using a command-line tool, the 
Android debug bridge (go.pcworld.com/androiddebug), or 
deactivating admin rights in Safe Mode (go.pcworld.com/
androidsafemode), according to Stefanko.

In the case of Porn Droid, if someone tries to deactivate the admin 
privileges, the malware uses a call-back function to reactivate them, 
Stefanko wrote.

The malware is also coded to try to shut down three mobile 
antivirus products: Dr. Web, ESET’s Mobile Security, and Avast. 

More advanced users may be able to get rid of Porn Droid without 
resetting and erasing all data on their phone. It is possible to remove 
the malware if a user has root privileges to the device, and some 
security software can stop it, Stefanko wrote.

Ransomware attacks, both desktop and mobile, have become some 
of the most persistent and damaging scams on the Internet. One of 
the most prevalent scams is encrypting a person’s files and asking for 
money for the files to be decrypted.

Security experts generally advise not paying the ransom, as in many 
cases fraudsters never bother to fix the victim’s computer. 

Other kinds of Android 
malware locked the screen 
by keeping the ransomware 
warning in the foreground 
using an infinite loop. 
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SURE,
AT FIRST I WAS A LITTLE TAKEN ABACK 

BY THE WHOLE PEEING STANDING UP THING. 
BUT I TAUGHT HIM TO THROW A STICK 

AND NOW HANGING OUT WITH HIM
IS THE BEST PART OF MY DAY. 



SONY MOBILE IS changing its stance over its waterproof phones. 
Apparently, when the company says Xperia phones are waterproof, it 
just means that if you try to use them underwater you’ll end up with 
proof that H2O can destroy your phone. Well, not quite—but Sony’s 
got a lot of explaining to do.

The company was not available for comment at the time of this writing. 
The waterproof explanation page (go.pcworld.com/xperian-

h20proof) for Sony Mobile Xperia phones now includes the following 
disclaimer, “Remember not to use the device underwater,” as first 
noted by Xperia Blog (go.pcworld.com/xperianblog). That’s a surprising 
turnaround considering the company has advertised Xperia waterproof 
phones with images of people using their phones underwater.

BY IAN PAUL

Don’t use waterproof Xperia 
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Xperia waterproof phones typically have 
an IP65/68 rating, which means they are 
completely resistant to dust, can resist 
low-pressure water jet spray for at least 3 
minutes, and can remain functional after 
immersion below a minimum 1 meter (3.28 feet) depth.

The problem seems to be that when Sony tested each device to 
achieve its IP rating the test wasn’t exactly rigorous. “Sony devices 
that are tested for their waterproof abilities are placed gently inside a 
container filled with tap water and lowered to a depth of 1.5 meters,” 
Sony’s waterproof page says. “After 30 minutes in the container, the 
device is gently taken out and its functions and features are tested.”

In practical terms this means Xperia waterproof phones can stand up 
to a heavy rainstorm, a non-water immersing web browsing session in 
the bath, or a run under the bathroom faucet. But all those shots of 
fun-loving people taking videos in lakes and chlorine-laden swimming 
pools? That’s pushing it.

At least according to some pages. As Xperia Blog points out, other 
parts of Sony Mobile’s site still encourage you to dive underwater with 
your device.

For the most part, however, Sony warns you on the limits of its non-
waterproof waterproof phones. Case in point is the company’s Xperia 
M4 Aqua (go.pcworld.com/m4aqua). Dubbed the “waterproof camera 
phone for everyone” it has this under the fine print: “You should not 
put the device completely underwater or expose it to seawater, salt 
water, chlorinated water, or liquids such as drinks. Abuse and/or 
improper use of the device will invalidate warranty.”

The impact on you at home: If you have an Xperia waterproof phone 
you should heed Sony’s warning even if you’ve taken underwater shots 
with your phone in the past. Should it get damaged during such an 
excursion, Sony could refuse to help and point to its support materials 
that warn against taking them into the water. Sure, it has tons of 
marketing materials encouraging the opposite, but those images 
aren’t to be taken literally, it seems. 
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How many light bulbs
        does it take

to change an American?

It’s no joke: climate change is a critical issue for all life 
on Earth. But can the actions of one individual really 
make a difference? Visit nature.org to calculate your 
impact on the world around you and learn about steps 
you can take to make the world a better place for us all.

nature.org/calculate
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We’ve tested the top browsers—Google Chrome, Microsoft’s Edge and 
Internet Explorer, Mozilla Firefox, and Opera—against a variety of 
simulated and real-world tests, and picked a winner. 
BY MARK HACHMAN

The best web browser of 
2015: Firefox, Chrome, Edge, 
IE, and Opera compared





THE BEST BROWSERS go beyond benchmarks, racing 
through real-world webpages as well as canned routines. 
They’re easy to set up, flexible and extensible, and connect 
other devices and services into an ecosystem. 

Look, throwing a few benchmarks at a browser just doesn’t cut it any 
more. Just as you expect us to test graphics cards against the latest 
games, we think your browsers should be tested against a collection 
of live sites. Can they handle dozens of tabs at once? Or do they 
shudder, struggle, and crash, chewing through your PC’s processor and 
memory? 

To pick a winner, we put Google Chrome, Microsoft’s Edge and 
Internet Explorer, Mozilla Firefox, and Opera to the test, barring 
Apple’s abandoned Safari for Windows. We used the latest available 
version of each browser, except for Firefox, which upgraded to Firefox 
40 late in our testing. And we also tried to look at each browser 
holistically: How easy was each to install and set up? Does Opera make 
it simple to switch from Chrome, for example?

Our tests have shown that enabling Adobe Flash can have much of 
an impact on your system. Disabling or refusing to load Flash can 
seriously improve performance—some sites, like YouTube, have begun 
to transition to less CPU-intensive HTML5 streams. Still, other readers 

 For 2015, we 
have a 
newcomer: 
Microsoft’s 
Edge browser, 
which has been 
integrated into 
Windows 10. 





pointed out that they simply need to run Flash on their favorite sites. 
That’s fine—we tested with and without Flash, so you’ll have a sense 
for which browser performs best, in either case.

Oh, and Microsoft: We found that your new Edge browser isn’t quite 
as fast as you make it out to be. (Sorry!) But it still demonstrated 
definite improvement over Internet Explorer.

The benchmark numbers favor  
Chrome and Firefox
We do consider benchmarks to be a valuable indicator of performance, 

Google Chrome 
and Mozilla 
Firefox do well 
here. (A higher 
result is better, 
except for the 
Sunspider 
benchmark.)
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just not a wholly defining one. Still, they’re the numbers that users 
want to see, so we’ll oblige. We used a Lenovo Yoga 12 notebook with 
a 2.6GHz Intel Core i7-5600U inside, running a 64-bit copy of Windows 
10 Pro on 8GB of memory as our test bed.

We tested Chrome 44, Windows 10’s Edge 12, Firefox 39, Internet 
Explorer 11, and Opera 31 against two popular (though unsupported) 
benchmarks—Sunspider 1.0.2 and Peacekeeper—just for reference 
purposes. But we’d encourage you to pay attention to the more 
modern benchmarks, including Jet Stream,  Octane 2.0, Speedometer 
(go.pcworld.com/speedometer), and WebXPRT. The latter two are 
especially useful, as they try to mirror actual interaction with web 
apps. We also tested using Oort Online’s graphics benchmark as well as 





the standardized HTML5test—which is not so much a benchmark, but 
an evaluation of how compatible a browser is with the HTML5 
standard for Web development.

From our testing, Chrome and Firefox topped the Speedometer and 
WebXPRT tests, respectively. Perhaps unsurprisingly, Google was the 
fastest browser under the Google-authored Octane 2.0 benchmark. 
But Microsoft’s Edge led the pack in the Jet Stream benchmark—
which includes the Sunspider tests, which Edge led as well. (For all of 
the benchmarks, a higher number is better; the one exception is 
Sunspider, which records its score in the time it took to run.)

What’s surprising about Edge is that it led the pack in the Jet Stream 
benchmark, but fell way behind on Speedometer, only to record a 
quite reasonable score in WebXPRT. (Microsoft claims that Edge is 





faster than Chrome in the Google-authored Octane 2.0 benchmark as 
well, but our results don’t indicate that.)

Chrome flopped on the Sunspider test; the only test Firefox failed 
equally miserably in was the Oort Online benchmark, which draws a 
Minecraft-like landscape using the browser.

For whatever reason, I noticed some graphical glitches as Edge 
rendered the Oort landscape, including problems drawing a shadow 
that slid across the bay in the night scene. But Oort proved even more 
problematic for Firefox, rendering “snow” as flashing lights and rain as 
a series of lines. (We’ve included the test result, but take it with a grain 
of salt.) Internet Explorer 11 simply couldn’t run the Oort benchmark 
at all.

We also included the HTML5test compatibility test, which measures 
how compatible each browser is with the latest HTML5 Web 
standards. Although some developers focus extensively on each 
browser’s score, even the test developer isn’t too concerned:

HTML5test scores are less interesting to me than people think. Any browser 
above 400 points is a perfectly fine choice for todays web.

 — HTML5test (@html5test) August 2, 2015. 

And the only one that fails that test, of course, is the semi-retired 
Internet Explorer 11.

What does all this mean? It doesn’t indicate a clear win for any 
specific browser, including Chrome. Based on our benchmark tests, 
many of the browsers will handle the modern web just fine.

Real-world testing: Opera makes its case
Opera Software has always lived on the periphery, with what 
NetApplications (netmarketshare.com) says is just 1.34 percent of the 
worldwide browser market. With Opera considering putting itself up 
for sale (go.pcworld.com/operaforsale), it may not be long for this 
world. But in terms of real-world browser performance, Opera is worth 
a long hard look while you still can.

Why? Because in real-world browser tests, Chrome and Opera 
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performed very well.
It’s important to know 

how each browser will 
actually perform while 
surfing the live web. 
Testing this is a 
challenge—some canny 
Web sites constantly 
tweak their content, and 
ads will vary from one visit 
to the next.  But we tried 
to minimize the time over 
which we visited each site 
to help minimize variation.

We used a selection of 30 live sites, from Amazon to CNN to iMore to 
PCWorld, as well as a three-tab subset of each, to see how 
performance scaled. Our tests included adding each site to a new tab, 
one after another, to weakly approximate how a user might keep 
adding new tabs—but quickly, so as to stress-test the browser 
itself. Finally, we evaluated them with Adobe Flash turned on and off. 
(Both Opera and Firefox don’t natively ship with Flash, so we tested 
without, then downloaded the Flash plugin.)

After loading all 30 tabs, we waited 30 seconds, then totaled the 
total CPU and memory consumption of both the app itself, the 
background processes, and the separate Flash process, if applicable.

So what does all this mean? If you own a mid-range and low-end PC, 
you might have purchased one without a lot of memory, or with a less 
powerful CPU. In that case, you might consider switching your browser 
to something that’s more efficient.  

This chart contains a lot of information; you can click it to enlarge it. 
But what you should focus on are the differences in memory 
consumption (the yellow bars) and the differences in CPU 
consumption. We’ve included the raw data in a table at the bottom of 
the chart. In each case, a lower number indicates a more efficient 

You can 
configure the 
Microsoft Edge 
homepage to 
show you 
information 
that allows you 
to start your 
day. (iGoogle 
did this too, 
years ago.)





browser, with the one exception being Firefox (with Flash)’s zero 
scores, which we’ll cover in the chart.

Oddly enough, we noted an actual decrease in CPU consumption 
when Flash was enabled on the three-tab test, specifically within Edge, 
Firefox, and Opera—perhaps because the Flash plugin was more 
efficient at lighter workloads. As our previous report indicated, 
however, CPU and memory consumption soared when we started 
throwing tab after tab at each browser.

The other discrepancy that you may note is that Chrome, with Flash 
enabled, consumes nearly the memory that Edge does 

without Flash enabled. We double-checked this, but we did so on 
another day, where Edge’s memory consumption was even higher than 
what we recorded. (That’s probably due to just a difference in the ads 
and video the sites displayed.)

Chrome has a reputation for sucking up all the memory you can 
throw at it, and these numbers prove that out. But it also consumes 
relatively little of your CPU—which, if you scale down your tab use, 
makes its impact on your PC manageable. Opera, however, really 
shines. In fact, without Flash, Opera consumed just 6.6 percent of the 
CPU and 1.83GB of RAM during our stress test. With Flash on, Opera 
consumed 3.47GB of memory and 81.2 percent of my computer’s CPU.
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And Mozilla was getting on so well—
but with Flash on, tabs essentially 
descended into suspended animation 
until they were clicked on, then began 
slowly loading. It was awful. 
“Tombstoning” tabs that aren’t being 
used is acceptable, but please, load 
them first, Mozilla!

Finally, we tried loading pages, then 
timing how fast before the page 
became “navigable”—in other words, 
how soon one could scroll down. 
Fortunately, all the browsers we tested 
did well, although some were faster 
than others; Chrome and Opera did 
exceedingly well, especially with Flash turned off. In all, however, we’d 
say that any browser that can load pages at three seconds or less will 
suit your needs. (Keep in mind that the time to load pages depends in 
part on your Internet connection and the content of the page itself.)

The convenience factor
Since all of these browsers are free, ideally you should be able to 
download every one and evaluate it for yourself. And each browser 
makes it quite easy to pluck bookmarks and settings from their rivals, 
especially from Chrome and Internet Explorer. But manually exporting 
bookmarks is another story. It’s almost like telling the browser that 
you’re fed up with it—and Firefox, for example, passive-aggressively 
buries the export bookmarks command a few menus deep. Even 
stranger, Opera claims that you can export bookmarks from its Settings 
menu, but only the import option appears to have remained in Opera 31. 

More and more, however, browsers are using a single sign-on 
password to identify you, store your bookmarks online, and make 
shifting from PC to PC a snap—provided that you keep the same 
browser, of course.

 Many 
browsers, 
including 
Opera, now 
allow you to 
sync your 
information 
across multiple 
devices. 
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Chrome, for example, makes setting itself up on a new PC literally as 
simple as downloading the browser, installing it, and entering your 
username and password. You may have to double-check that the 
bookmark bar is enabled, for example, but after that your bookmarks 
and stored passwords will load automatically. (As always, make sure 
that “master” passwords like these are complex.)

Chrome isn’t alone in this, either. Firefox’s Sync syncs your tabs, 
bookmarks, preferences and passwords, while Opera syncs your 
bookmarks, tabs, the “Speed Dial” homepage, and preferences and 
settings.

That’s an area where Edge needs improvement. Edge can import 
favorites/bookmarks from other browsers, manually, but doesn’t keep 
a persistent list of favorites across machines—at least not yet. But if 
you save a new favorite in IE11, it’s instantly available across your other 
PCs. Other browsers—not Edge—also allow you to access your 
desktop bookmarks within their corresponding mobile apps. 

It’s also interesting that, more and more, browsers are moving away 
from the concept of a “homepage” in favor of something like Edge or 
Opera, where the browser opens to an index page, with news and 
information curated by the browser company itself. But you still have 

Right-click a 
term, and 
Microsoft 
Edge’s Cortana 
swoops in to 
assist.





options to set your own homepage in Chrome, Edge, and Firefox.
Honestly, all of the browsers we tested were relatively easy to set up 

and install, with features to import bookmarks and settings either 
from other browsers or other installations. You may have your own 
preferences, but it’s a relative dead heat.

Going beyond the web
Modern browsers, however, go beyond merely surfing the web. Most 
come with a number of intangible benefits that you might not know 
about.

Perhaps you’d like your browser to serve as a BitTorrent client, for 
example. In the early days, you’d need to download a separate, specific 
program for that. Today, those capabilities can be added via plugins or 
addons—which most browsers offer, but not Edge, yet. (This can be 
more than a convenience; Edge will store your passwords, but not in an 
encrypted password manager like LastPass.)

If there’s one reason to use Firefox, it’s because of the plugin 
capability. Mozilla has a site entirely dedicated to plugins (addons.
mozilla.org), and they’re organized by type and popularity. Installing a 
plugin is as easy as clicking through a couple of notifications, then 
restarting your browser. And given the market share of Chrome—and 
the plugin popularity of Firefox—you’ll find developers who will focus 
on those two first. A good example is OneTab (one-tab.com), which 
transforms all of your open tabs into a text-based list, dramatically 
cutting your browser’s memory consumption. Note that the more 
plugins you add and enable, the more memory and CPU power your 
browser will consume.

Opera doesn’t appear to have nearly the number of available plugins  
(addons.opera.com) that Firefox does, but it does have a unique twist: 
a “sidebar” along the left hand side that can be used for widgets, like a 
calculator or even your Twitter feed. Opera is also extensible via 
wallpaper-like themes, but they’re far less impressive.

But you’ll also notice browsers adding more and more functionality right 
in the app itself. Firefox includes a Firefox-to-Firefox videoconferencing 





service called Firefox Hello that works right in your browser, and you can 
save webpages to a Pocket service for later reading. And this is where Edge 
shines—its digital assistant, Cortana, is built right in, and there are Reading 
View options and a service to mark up webpages, called Web Notes. 
Cortana does an excellent job supplying context, and it’s certainly one of 
the reasons to give Edge a try.

Over time, we expect that this will be one area where Edge and 
Chrome will attempt to “pull away,” as it were. In a way, it’s similar to 
the race in office suites: a number of apps mimic functionality that 
Microsoft Office had a few years ago. But Microsoft has begun building 
intelligence into Office, and Edge, elevating them over their 
competition. Given that Chrome is also the front door to Google Now 
on the PC, we may eventually see Google try to out-Cortana Cortana 
on her home turf.  

Chrome narrowly beats Opera
So who wins? Here’s the way we see it.

Give credit where credit is due: Edge’s performance has improved to 
the point that it’s competitive, though perhaps not as much as 
Microsoft would make it seem. Still, its lack of extensibility and proper 
syncing drag it down, at least until they’re added later this year. Firefox 
also performed admirably, until it bogged down under our real-world 
stress test. We also believe Opera would be a terrific choice for you, 
since it zips through benchmarks and real-world tests alike. Sure, it 
lacks the tight OS and service integration of Chrome, IE, and Edge—
but some may see that as a bonus, too.

All that said, we still think Google’s Chrome is the best of the bunch.
Chrome has a well-deserved reputation for glomming on to and 

gobbling up any available memory, and our benchmarks prove it. But 
it’s stable, extensible, performs well, integrates into other services, and 
reveals its depths and complexity only if you actively seek it out. For 
that reason, Google Chrome remains our browser of choice, with 
Opera just behind.    
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We tested the effects of browsing with and without Flash on several 
major browsers. Enabling Flash is, in a word, catastrophic. 
BY MARK HACHMAN

Tested: How Flash destroys 
your browser’s performance

Last month, the axe seemingly came down on Adobe Flash: three 
undiscovered vulnerabilities in Flash were leaked (go.pcworld.com/
flashleaked) and exploited (go.pcworld.com/flashexploited). In 





response, Mozilla’s Firefox blocked Flash by default (go.pcworld.com/
ffblockedflash) until Adobe issued a patch. You should know by now 
that installing Flash equals a security risk. But are you aware of how 
badly your PC can slow down as well?

Try 80 percent. 
As part of our roundup of the major browsers, we tested their 

abilities to handle Flash. Two browsers, Mozilla Firefox and Opera, do 
not include Flash, although you can download a plugin from Adobe to 
enable it. A third, Microsoft’s new Edge browser, enables Flash by 
default, although you can manually turn it off. Both Internet Explorer 
11 and Google’s Chrome also include Flash, which you can disable or 
adjust within the Settings menu.

Adobe Flash is one of those legacy applications that just doesn’t 
seem to go away. There’s seemingly no real reason to install it—until 
you run into a blank spot on a page that asks you to install or update 
the Flash plugin. So you sigh, download (or enable) the plugin, and go 
back to browsing. Removing Flash and another PC security risk, Java, 
can be done—but it takes some effort. And most of us just aren’t 
inclined to do so.
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information 
superhighway 
is increasingly 
littered with 
ads, popups 
and worse.





Testing in the real world
Let’s start from the totally naive premise that Flash does not represent a 
security risk. Vulnerabilities occur in the background, surreptitiously 
lifting your data, installing rootkits, and the like. But they don’t impact 
your day-to-day browsing, right?  Maybe not. But simply using a browser 
with Flash installed can have major consequences on performance.

As we did in our Windows 10 review, we used a test bed of 30 live 
sites, ranging from Amazon to The New York Times to iMore to PCMag.
com. Most of them have all sorts of embedded ads and trackers, which 
the sites use to track you, create a profile, and sell you stuff. Since they 
are live, there’s always a possibility that ads and content can change 
from one visit to the next, but we were able to do our live testing over 
the course of a single day to try and minimize this.

We tested Chrome 44, Windows 10’s Edge 12, Firefox 39, Internet 
Explorer 11, and Opera 31—all the latest versions at press time. We 
ignored Apple’s Safari browser—sorry, Apple. For Firefox and Opera, we 
ran our tests without Flash installed, then downloaded the plugin 
from Adobe’s site. With Edge, we toggled Flash on and off, using its 

You can dig 
into the Task 
Manager (WIN 
+ X) to find out 
what's 
chewing up 
your system 
resources. All 
these 
background 
processes slow 
your PC down.
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built-in control. We used a Lenovo Yoga 12 notebook with a 2.6-GHz 
Intel Core i7-5600U inside, running a 64-bit copy of Windows 10 Pro on 
8 GB of memory.

Measuring the impact on your PCs CPU and RAM is somewhat 
subjective. Loading a page can take as little as a few seconds, for a 
text-heavy page with few embedded elements. Pages with embedded 
video, pre-roll advertising, and the like, can take over a minute. We 
tried to split the difference.

From our list of links, we cut and pasted each link into a new tab, weakly 
approximating how a user would add one tab, then another. But we did it 
quickly, to try and stress the browser by throwing a number of elements 
at it, all at once. After loading all 30 sites, we then waited 30 seconds for 
things to settle down, before opening Windows 10’s Task Manager and 
recording the CPU load and memory consumption of both the apps as 
well as the background processes. If applicable, we added Flash’s CPU and 
memory load as well. (We snapped a picture of the screen, then copied 
the values in by hand—a browser like Chrome, for example, has a ton of 

Simply turning 
on and off Flash 
can make a 
significant 
difference in 
the amount of 
resources your 
browser uses.





background processes, all dynamically changing by the second.)
It’s important to note that, especially with a midrange PC, that the 

amount of CPU cycles an app chews through will probably be what 
causes your PC to stutter and pause—and that’s going to be what 
frustrates you most.

OMG, Flash
What we found was shocking. 

We condemned Microsoft Edge, for example, for locking up in 
previous iterations of our 30-tab stress test. With Flash enabled, Edge 
survived—a testament, perhaps, to a massive bloc of updated code 
that Microsoft recently released. With Flash enabled, Edge chewed 
through 4.72 GB of memory, sucking down 84.1 
percent of my PC’s CPU cycles. With just Word 
Mobile open, that left my system functional. 

 But when I toggled Flash off, the same tabs 
required 4.12 GB of memory, and just 24.5 
percent of my CPU. That’s an 11 percent drop 
in memory consumed, and a whopping 61 
percent decrease in CPU consumption.

And it just got better from there. Opera really 
surprised me with how efficiently it performed, 
consuming just 3.47 GB of memory with Flash 
enabled—the lowest of all the browsers we 
tested. It chewed through 81.2 percent of our CPU. But as a clean install, 
without Flash, Opera consumed 1.8 Gbytes and just 6.6 percent of our 
CPU cycles. Pages seemed to load like shots from a gun: pow, pow, pow!

Firefox? Well, Firefox did swimmingly as well, when you removed Flash 
from the equation. It consumed 1.65 GB, and needed only 24.5 percent of 
the CPU. But after I downloaded Flash, Firefox seemed to throttle itself. 
The browser never climbed above 29.1 percent of the CPU, but some tabs 
were unresponsive minutes after loading, and I had to manually check each 
tab to check on its progress. That was totally unacceptable.

Chrome also consumed 4.23 Gbytes of memory, and 71.4 percent of 

But when I toggled 
Flash off, the same 
tabs required 4.12 GB 
of memory, and just 
24.5 percent of my 
CPU. That’s an 11 
percent drop in 
memory consumed...





the CPU, with Flash enabled. That was pretty good, just by itself.

For Edge, some redemption
Of all the features that Microsoft highlighted with Edge—its Web 
Notes, Cortana, the Reading View—the one that jumps out, now, is its 
ability to toggle Flash off and on. Frankly, all the messaging I’ve seen 
from Microsoft—and the reviews, to boot—have focused on its 
performance on a few canned benchmarks, rather than real-world 
browsing performance. And with Flash turned on by default, that 
performance has been lousy.

I can’t say for certain which pages require Flash to be functional, if 
only because I’ve tolerated Flash for so long. But the toggle at least 
offers the possibility that Edge can be the modern, streamlined 
browser that Microsoft hopes it to be.

Edge, however, doesn’t offer a middle ground. In Firefox, you can set 
Flash in a “click to run” mode: Flash is installed, but it won’t fire unless 
you manually tell it to. (Chrome used to have a "Click to Play" option 
for Flash, but it seems to have disappeared.) In Firefox, you’ll need to 
find the “Add-ons” menu, then set the Flash plugin(s) to “Ask to 
Activate”.) In Edge, 
Flash is either on, or off. 

Ideally, being able to 
turn Flash on and off on 
a per-tab basis might 
be even better, but the 
Edge team doesn’t 
seem to have that on 
their feature roadmap.

How do you 
turn off Flash?
If you already have a 
browser with Flash 
installed and think you 
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Advanced 
Settings menu.





might do better without it, don't worry. Here's a quick guide to 
removing it:

 Microsoft Edge: This is easy. Click the "ellipsis" (...) menu to the 
upper right, the Settings>Advanced Settings. Flip the Adobe Flash 
toggle to "Off".

 Google Chrome: From the "hamburger" (three horizontal lines) 
menu in the upper right, click Settings, then scroll down to "Show 
advanced settings". Under "Privacy," click "Content Settings". Scroll 
down to "Plug-ins," then "Manage Individual Plugins". You'll have the 
option to turn Flash on or off.

 Internet Explorer: Click the "gear" Settings icon to the upper right. 
Scroll down to "Manage add-ons". When you're presented with a list, 
click on the "Shockwave Flash Object" and the "disable" button, way 
down in the lower right.

 Mozilla Firefox: In Firefox, you’ll need to go to the hamburger menu 
in the upper right, then click the “Add-ons” menu, then set the 
Shockwave Flash plugin to “Never Activate".

 Opera: This is a bit tricky. To uninstall Flash in Opera, you need to go 
to the Windows 10 Control Panel>Programs>Programs and Features 
menu, then manually uninstall Adobe Flash Player PPAPI. (Thanks to 
HowtoGeek for the tip.)

Stay tuned for our full review
Flash obviously isn’t the only culprit preventing you from browsing 
efficiently: Javascript, other plugins, ads, and the like all bog down your 
browser and prevent it from seeing the content that matters. But as 
our tests prove, Flash certainly makes a tremendous difference.

Soon, we’ll present our full set of benchmark results comparing the 
top browsers, and how they fare on Windows 10. Each has their own 
particular set of skills. What we’ll tease you with, however, is the 
message we hope you take away from this: eliminating Flash can make 
a world of difference in your day-to-day browsing, and is just as 
important as any benchmark.    





The Lenovo Miix 700 is a Lenovo Surface, plain and simple. 
BY MARK HACHMAN

Hands-on: Lenovo’s Miix 
700 looks and feels like a 
Surface, but better

THE LENOVO IDEAPAD Miix 700 is simply a Lenovo Surface—just a bit 
better.

That might not be the most intriguing way of introducing Lenovo’s 
Surface clone, but it’s the most accurate. Place them side by side, 
eliminate some of the external markings, and you’d be hard-pressed to 
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tell the difference between the two.
But which Surface? It depends 

on which one you’re comparing 
Lenovo’s tablet against. The Miix 
700 is a 12-inch tablet, the same 
form factor as the Surface Pro 3. 
But with processors reportedly 
ranging up to the new Skylake 
Core m7 (Lenovo demonstrated it 
with a Core m5 at its stand at IFA) 
it might be more on a par with the 
Surface 3. The Miix 700 can be 
configured with up to 8GB of memory, and will run Windows 10.

 As for the price, well, it’s somewhere in the middle: $499 for the 
Surface 3, $799 for the Surface Pro 3, and a starting price of $699 for 
the Miix 700. We’ve heard that it should be out in the United States 
this fall, most likely in November.

 Why this matters: We’ve yet to see the Surface Pro 4 or Surface 4 
from Microsoft (reportedly, that’s all happening in November). But for 
now, Lenovo is offering a cheaper Surface Pro 3 that steps down a bit 
in performance. Yes, it’s a Surface clone—but don’t mock Lenovo for 
that. I suspect that this was done with Microsoft’s blessing, as 
Microsoft has indicated that it plans to blaze a trail with new products 
to empower the industry, and not just itself.

Surface, reMiixed
If you’ve ever used a Surface, you’ll be right at home with the Miix 700. 
Yes, there’s a kickstand, with the full range of motion as found in the 
Surface Pro 3. The Miix also adds the styling of the Yoga hinge, 
although that doesn’t seem to make any functional difference.

The screen resolution is 2160 x 1400, the same as that on the 
Surface Pro 3. Even the way that the keyboard folds back and connects 
via a long rectangular hinge is similar to the way that Microsoft does 
things. If I had to guess, Lenovo likely packed that space behind the 
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tablet screen with a battery. With a 4.5-watt Core M chip hiding 
behind a larger, SP3-style screen, I’d estimate the Miix 700’s battery 
life to be pretty darn good—at least 8 hours.

And that keyboard is decidedly Lenovo. Instead of the closely spaced 
keys of the Surface and Surface Pro Type Covers, the 
Miix 700’s keys are smaller, spaced out a bit, and 
offer much more resistance. I can’t say which you’ll 
prefer; my fingers have become used to gliding over 
the smooth expanse of the Surface keyboards, but 
Lenovo fans will undoubtedly find much to like here.

Reportedly, Microsoft plans to launch a Surface 
Pro 4 and possibly a Surface 4 at an event in October. It’s a safe bet 
that the next Surface Pro 4 will add an Intel Skylake chip, and thus 
more performance. That’s going to help it pull away from the Surface 
Pro 3 and the Miix.

If you own a Surface 3 or a Surface Pro 3, keep them—they’re solid 
products. But if you’re interested in a new Surface-style PC, definitely 
add Lenovo’s tablet to the, um, mix.  
 

I’d estimate the Miix 
700’s battery life to 
be pretty darn good—
at least 8 hours.





Apple’s answer to the Surface Pro tablets is built for work, 
with a huge screen perfect for multitasking and an Apple 
Pencil for precision design and artistry. 
BY SUSIE OCHS

Hands-on with iPad Pro 
and Apple Pencil, built 
for getting stuff done

Five years after its launch, the iPad is growing up. The new iPad Pro 
(apple.com/ipad-pro), introduced at Apple’s media event recently, 
blurs the line between iPad and MacBook just a little more, with a 

Watch the 
video at

go.pcworld.
com/newprod





12.9-inch screen capable of running two apps side by side without 
either of them feeling cramped in the slightest.

But as large as it is, the iPad Pro doesn’t feel unwieldy, even to me, an 
avowed fan of the iPad mini. We’ve learned from both the iMac and 
the iPhone that people love giant screens with tons and tons of pixels 
crammed on to them, and that’s what the iPad Pro delivers, along with 
performance that should let more people than ever leave their 
laptops at home.

Thin and light
The iPad Pro is only 1.57 pounds, which is astonishing since my first-
generation iPad is still in active service at my house, and it weighs 1.54 
pounds. The iPad Pro is so much bigger but doesn’t feel unbalanced or 
awkward. I could hold it easily, but—and I realize you’ll make fun of me 
for this, and that’s OK—I sort of wished it had a kickstand like the 
Surface Pro.
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But once you have it propped up just how you like, the iPad Pro’s 
screen looks amazing. At 2732x2048 resolution, it’s got 5.6 million 
pixels, and the short side has as many pixels as the longer side of an 
iPad mini. I was impressed with the responsiveness of iOS 9 on this 
tablet, as I easily pulled out the sidebar and entered Split Screen view.

Pencil power
You don’t need a stylus to use any iPad, and the iPad Pro is no 
exception. Luckily, the Apple Pencil (apple.com/apple-pencil) isn’t a 
stylus. It’s not aimed at pointing and tapping things you can reach just 
fine with your fingers, thanks. Rather, it’s for pressure-sensitive 
drawing and painting in apps as simple as Apple’s own Notes app, or as 
complex and professional as the demonstrated Procreate or AutoCAD.

The Pencil felt great from the moment I picked it up. It feels like a 
pencil, very natural (although you can say the same for other smart 
Bluetooth styluses on the market), and using it felt natural too. 
Sensors can detect the pressure and angle, so it was effortless to 

Apple Pencil is 
a $99 add-on 
that only 
works with the 
iPad Pro.
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create lines of different thicknesses. The 
Notes app even has a ruler that let me draw 
perfectly straight. Using the side of the 
Pencil’s tip created realistic shading, like 
using the side of a pencil lead.

A Lightning connector hidden in the end 
of the Pencil lets you plug it right into the 
iPad Pro for charging. An Apple rep told me 
that its quick-charging feature lets it grab 
enough juice for another hour or so of work 
in just a few minutes, and a full charge 
should last all day. You can plug it into an AC 
charger with an adapter that I didn’t get to 
see—and I dearly hope is included in the 
purchase price.

Apple also created its own Smart Keyboard 
(apple.com/smart-keyboard), similar in 
appearance to the Touch Covers that 
Microsoft makes for the Surface tablets. It 
closes around the front of the iPad Pro and 
flips back to form a stand, just like the Smart 
Covers Apple has made for a while. But it has 
a built-in, fabric-surface keyboard with short 
key travel similar to the new MacBook. Third-
party keyboards will be able to use the iPad 
Pro’s Smart Connector, which powers and pairs the keyboard for you 
automatically—Logitech just announced one (go.pcworld.com/
logitechipadkeys). I actually didn’t get hands-on with it—by the time I 
got all the photos and video I needed of everything else, it was getting 
late and they were packing it up. But that’s OK, because my colleague 
Jason Snell wrote his More Color column on his hands-on time with the 
Smart Keyboard (go.pcworld.com/snellsmartkeyboard), so we’re all in 
luck. (Thanks, Jason.)

The Lightning connector for charging is hidden in 
the end of the Pencil. 

You can charge the Pencil directly from the iPad Pro, 
or use a charger with the help of (sing it with me) an 
adapter. 





More of the same, FTW
Apple talked about how much faster the iPad Pro’s A9X chip is than 
the A8X in the iPad Air 2, but remained characteristically mum about 
details like how much RAM it has. Apple has teamed up with IBM to 
create iPad apps to be used for all kinds of work, since anything a 
clipboard can do, an iPad can do so much better, and having a laptop-
quality iPad Pro on the high end of the line can open up more 
possibilities for people who need big power in a package that’s half a 
pound lighter than the MacBook. My demo running splitscreen 
Microsoft Office apps was impressive, but when developers put the 
pedal to the iPad Pro’s Metal, it’s going to be fun to see what happens.

The new iPad Pro starts at $799 for a 32GB model with Wi-Fi. If you 
want more storage, there’s a 128GB model (nope, no 64GB) with Wi-Fi 
for $949. Gotta have cellular? Your only option is a 128GB version for 
$1079. The Pencil is $99 and the Smart Keyboard is $169. Everything 
ships in November.  
 





There’s no other graphics card quite like the AMD R9 Nano,  
which packs full-size performance into its six-inch frame—but  
it’s not for everyone.
BY BRAD CHACOS

AMD Radeon R9 Nano:  
A powerful taste of the PC’s 
incredible shrinking future







AMD DESERVES SOME serious props for 
even creating the Radeon R9 Nano (go.
pcworld.com/r9nano) in the first place.

This pint-sized powerhouse is the 
latest in a long line of AMD technical 
innovations that skate to where the puck 
is going, rather than where the puck is 
lingering today. Built around 
revolutionarily tiny—and fast—high-
bandwidth memory, the six-inch Radeon 
R9 Nano delivers flagship-level 
performance in a form factor that fits 
where most other graphics cards simply 
can’t.

In an age where graphics cards keep 
expanding with heat pipes and heat sinks 
and fans in order to push performance to 11, 
the Nano’s more holistic design approach is a breath of fresh 
air, dragging mini-ITX (mITX) graphics cards out from the shadows and 
into the spotlight. It truly feels forward-thinking—the first top-tier 
graphics card designed for a future where mainstream computing 
increasingly shifts towards NUCs and Steam Machines and small-form-
factor designs and PCs-on-a-stick. There’s no other card out there like 
quite it, and the Nano will bring tremendous joy to the people pining 
for its particular blend of high-end features.

But pushing the PC ecosystem forward isn’t possible without some 
growing pains. The $650 Radeon Nano rocks, but it won’t appeal to 
everybody—not by a long shot.

Let’s dig in.

AMD Radeon R9 Nano under the hood
The $650 asking price for the Radeon R9 Nano shocked some people, 
but AMD’s deft design of the Nano goes a long way toward justifying 
the flagship-level cost. This is the most powerful mini-ITX graphics 
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card ever created, and every aspect of it screams premium.
The Nano’s six-inch length is its most notable feature, naturally, 

enabled by the tremendous space and power savings of high-
bandwidth memory, which is integrated with the GPU. The card’s a hair 
smaller in both length and width than Asus’ GTX 970 DirectCU Mini, 
the Nano’s closest GeForce-based miniature competitor. (Nvidia 
doesn’t offer mini-ITX variants of the GTX 980 or 980 Ti.)

And it’s downright puny compared to the hulking Asus Strix Fury. The 
Fury is AMD’s other air-cooled graphics card built around a Fiji GPU and 
cutting-edge high-bandwidth memory.

We placed the Radeon Nano next to a pencil and a battery for yet 
more scale. It’s small.

The Nano takes its design cues from AMD’s other flagship, the also 
$650, water-cooled Radeon R9 Fury X. The Nano features a black metal 
shroud with a soft-touch aluminum finish, with RADEON emblazoned 
in bright red across its front and outer edge. It lacks a backplate, 
however, and for cooling it sticks to a single fan integrated in the 
shroud, sitting atop a card-length heat sink with horizontal fins. The 

Now that’s a 
cooler. The 
Radeon R9 
Nano’s cooler, 
to be exact.
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GPU itself stays chilly thanks to a hybrid 
flattened-heatpipe/vapor-chamber solution. 
There’s even a dedicated copper heatpipe just for 
the Nano’s voltage regulator module.

Our deep dive into the Nano’s design shines 
even more light on its inner workings, but the 
important part is that the cooling setup works 
well, as you’ll see once we wade into benchmarks. 
That’s a good thing, because AMD says 
customized Nanos from its graphics vendor 
partners (like Asus and Sapphire) won’t 
necessarily be available. If they ever are, it’ll be at 
least three months after launch—and even then, 
third-party vendors won’t be allowed to touch the 
GPU’s base specs.

Speaking of which, those specs are no joke. The 
Radeon R9 Nano packs the same full-fat, 4096 
stream processor-strong Fiji graphics processor as 
the Fury X, along with the same 4GB of HBM. The 
Nano’s GPU isn’t an exact mirror of its bigger 
sibling, however: In order to squeeze Fiji into a 
mITX form factor without liquid cooling, AMD 
reduced the clock speed of the Nano’s GPU 
enough to allow the card to consume a mere 175 
watts of energy over a single 8-pin power 
connector. The Fury X, on the other hand, requires 
two 8-pin connectors and 275W.

There’s more to it than the listed specs, 
however. On paper, the Fury X is clocked at 
1050MHz, while the Radeon R9 Nano hits up to 
1000MHz—but the Nano uses an aggressive version of AMD’s 
PowerTune technology to dynamically adjust the clock speeds to 
meet the card’s thermal and power targets. Observing real-time clock 
specs for the Nano using GPU-Z, it ran at 650MHz to 680MHz in the 

Process 28nm

Stream Processors 4096

Compute Units 64

Engine Clock Up to 1000 Mhz

Compute Performance 8.19 TFLOPs

Texture Units 256

Texture Fill-Rate 256 GT/s

ROPs 64

Pixel Fill-Rate 64 GP/s

Z/Stencil 256

Memory Configuration 4GB HBM

Memory Interface 4096-bit

Memory Speed / Data Rate 500 Mhz / 1.0 Gbps

Memory Bandwidth Up to 512 GB/s

Power Connectors 1 x 8-pin

Typical Board Power 175 W

PCle Standard PCle 3.0

API Support DirectX 12, Vulkan

FreeSync Support Yes

Virtual Super Resolution Yes

Frame Rate Target Control Yes

AMD Radeon R9 Nano
Product Specifications





Furmark benchmark 
(which both AMD and 
Nvidia call a “power 
virus”), typically 
859MHz to 926MHz in 
3DMark’s Fire Strike 
(though it dropped to 
700MHz during the last, 
most stressful scene), 
and 852MHz to 917MHz 
in Middle-earth: Shadow of 
Mordor.

That seems like a recipe for stuttering 
and frame rate issues, but nope: Games ran 
like a champ, while the card stayed cool and 
relatively quiet. AMD said the Nano would outpunch the 
older Radeon 290X flagship while using drastically less power, and 
spoiler alert: It does.

It also drastically outperforms the GeForce GTX 970, the most 
powerful mITX graphics card in Nvidia’s arsenal. Heck, the 
downclocked Fiji GPU in the Radeon 
R9 Nano even trumps a full-sized GTX 
980 in most cases.

PCWorld’s faithful graphics card 
testing system was pressed into action 
yet again for this review, loaded with 
all sorts of high-end parts See the our 
testing and gameplay benchmarks 
(go.pcworld.com/r9nanotests). 

So there you have it: All of AMD’s claims for the Radeon R9 Nano 
proved true in real life. This pint-sized powerhouse is one of the most 
capable graphics cards around, flirting with performance on a par with 
the Asus Strix Fury, a full-sized card with an imposing cooling setup. It 
demolishes the GTX 970, Nvidia’s most capable mITX graphics card. It 

AMD said the Nano would 
outpunch the older Radeon 
290X flagship while using 
drastically less power, and 
spoiler alert: It does.

The Radeon R9 
Nano on a mini-
ITX motherboard.
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runs cool and quiet, and it manages to outpunch both the 290X and 
390X while using far less power.

There’s no other graphics card like it. If you want uncompromising 
gaming performance from a mini-ITX PC and play at resolutions higher 
than 1080p, the Radeon Nano is easily the most powerful option 
available. Its diminutive stature and cool performance will allow it to 
fit into itty-bitty cases that full-sized graphics cards couldn’t even 
dream of squeezing into.

“For anyone who wants to build a small form factor chassis capable 
of playing 4K, the Nano is really interesting and that’s exactly where 
we targeted it,” AMD’s Victor Camardo said at a Nano press briefing 
last month. “For those people who want power efficiency, who want 
high-performance, who want a good overall gaming solution that’s 
optimized to take advantage of all aspects of the product, and not 
just push one curve or the other to the max.”

The AMD Radeon R9 Nano does just that. It feels unique. It feels 
forward-thinking, a harbinger in a world increasingly focused on 
cramming full PC performance into ever-smaller cases. And more  
than that, it feels premium, oozing style from every fiber of its  
being. People may scoff at the Nano’s $650 cost, but it manages to 





trade performance blows with the $580 Strix Fury 
and $530 EVGA  
GTX 980 FTW despite its far more 
diminutive stature and enviable power 
efficiency. 

It’s amazing. A hell of a 
graphics card. The Radeon 
Nano fully justifies its $650 
price point.

But most people 
shouldn’t buy it.

Stumbling points
The Nano isn’t just a niche 
product, it’s an ultra-niche prod-
uct—more a showcase for the space- and pow-
er-savings of HBM and Fiji than anything else. Currently, there 
are only a handful of (admittedly gorgeous) PC cases small enough to 
fit the Nano, but too compact for a larger graphics card. If size isn’t an 
issue, it makes more sense to spend your $650 on the far greater per-
formance of a Fury X or GTX 980 Ti. (See: PCWorld’s recent mITX build 
starring AMD’s liquid-cooled Fury X.)

What’s more, some technical issues hold back key would-be use 
cases for the Nano. At this size, the Nano just begs to be used in a 
killer home theater PC designed around a 4K TV… but the card’s lone 
HDMI port is 1.4a, not 2.0, which means it’s limited to 30Hz at that 
resolution. To be fair, Nvidia’s HDMI 2.0-equipped high-end GeForce 
cards lack HDCP 2.2 support so they can’t play protected 4K content, 
either. It’s still a bummer in a card like the Nano, however. To find a 
graphics card with HDMI 2.0, HDCP 2.2, and H.265 encode/decode, you 
have to look to the $200 GTX 960 or $160 GTX 950, which don’t offer 
anywhere near the gaming performance of the Radeon Nano.

Likewise, the small size and big-time performance of the Radeon 
Nano would make it seem well-equipped for Valve’s impending Steam 

The HDMI 1.4a 
port on the 
Radeon R9 
Nano hurts its 
claim to king of 
the HTPC 
throne.
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Machine army, but SteamOS is based on Linux, 
and frankly, AMD’s Linux drivers don’t perform 
well at all (though they’re working on it).

Finally, our lingering concerns about the air-
cooled Fury still apply to the Radeon Nano. Yes, 
it’s capable of gaming at 4K resolution—but only 
at 30 fps to 50 fps on High graphics settings in 
most games. The golden standard for PC gaming 
is 60 fps, so you’ll either need to pick up a 
FreeSync monitor to smooth out your gaming or 
dial the resolution back to 2560x1440, where the 
Nano rules the mITX roost—by far—but the GTX 
970 mITX still puts on an admirable show. And at 4K, 
the Nano’s 4GB of HBM is fine now, but I’d be 
worried about the long-term prospects of so little 
memory in future games at such high resolutions.

Add it all up, and you’re looking at a fairly niche 
market for the Nano—and gorgeous, powerful flagship products for 
niche markets always command a price premium. The Nano is easily 
worth the $650 for someone who needs its unique blend of features. 
Mini-ITX gaming PCs don’t need to compromise performance for size 
anymore.

Finally, let’s loop back to where we began: AMD deserves serious 
props for pushing HBM’s birth and creating this card in the first place. 
This is innovation. HBM’s radical power efficiency and space savings is 
the future of graphics card memory, and small form factors are 
increasingly becoming the new norm in desktop PCs, flogged on by 
the energy efficiency in Intel’s recent chips.

The AMD Radeon R9 Nano gives us a glimpse of that future today, 
fully earning its flagship status and hopefully—hopefully—
encouraging case manufacturers and the rest of the component 
ecosystem into further investments in itty-bitty gaming PCs. The 
Radeon R9 Nano may not make sense for most gamers today, but I’m 
thankful it exists, and I can’t wait to see the next version. 

AMD deserves 
serious props for 
creating this card 
in the first place. 





The Asus ROG GX700 kicks off a new generation of watercooled, 
overclockable gaming notebooks. 
BY MARK HACHMAN

Up close with the Asus ROG 
GX700, a massive, watercooled 
gaming notebook





When Asus announced the Asus ROG GX700 (go.pcworld.com/rog-
gx700) at IFA in Berlin, we knew its massive cooling block would be one 
of the must-sees of the show. We weren’t disappointed. On the other 
hand, what they showed was just a semi-functional prototype. So 
although we spent some hands-on time with it, we can describe only 
in vague detail what’s going on inside of it.

Asus has yet to reveal any specs. We can be almost certain that one 
of Intel’s new, overclockable Skylake chips is inside. One Asus 
employee told us it would include the forthcoming Nvidia GTX 990M, 
but we can’t confirm that. All we do know is that the watercooling 
system inside the notebook will cool both the GPU and CPU.

And oh, what a watercooling system it has. Detached, the ROG 
GX700 laptop runs normally, using air to cool both the CPU and GPU. 
It’s hefty, weighing well over five pounds. As of now, Asus plans for it to 
have a 17-inch, 4K IPS display.
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Like docking the Starship Enterprise
Docking the laptop is no simple feat. It must be lowered onto two 
vertical pins that align the laptop just so. Afterward, you’ll need to 
fasten a clamp that tightly connects it to that crazy external cooling 
system. All this is to ensure a snug fit between the central power port 
and the coolant channels that flank it.

When you dock the notebook correctly, a klaxon-like sound rings 
out, and lights flicker in the depths of the cooling unit. To undock it, 
you need to press a rather stiff button in the center of the cooling 
unit, which pops the notebook up and out.

Because the demo unit wouldn’t boot—nor was it, presumably, 
circulating coolant—we don’t know whether you’ll need to shut down 
the laptop before docking or undocking it, or whether you’ll have to 
worry about coolant drips each time you use it. And, of course, we 
have no idea of how the notebook will perform. Asus claims it’ll 
provide 80 percent more performance than a normal laptop using the 
same parts, but lacking the external cooler.
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Because the cooling unit is massive, there’s very little chance you’ll 
be toting this thing around. But it’s an intriguing design nevertheless. 
Even if gamers don’t opt for the ROG GX700’s massive cooling rig, Asus 
or other notebook manufacturers might be able to adapt the design. 
The end goal for a number of PC gamers would be something that 
could serve as a business notebook by day and a gaming notebook by 
night. The ROG GX700 was designed exclusively for gamers, but you 
just never know what the future holds.  

The GX700’s 
power port is in 
the center, 
flanked by the 
cooling 
channels.



A little bit of extra oomph in the clock speeds help make it the most 
enticing option for mainstream gamers today. 
BY BRAD CHACOS

AMD Radeon R9 380 feat. 
VisionTek: The best $200 
graphics card you can buy

THE BATTLE FOR PC gaming’s sweet spot is on.
The $150 to $200 price range is crucial for 

AMD, Nvidia, and all of their assorted 
partners. The overwhelming majority of 
graphics cards sold cost less than $200, 
with cards in that price range 
delivering a solid 1080p experience 
in modern games—and over 50 
percent off all PC gamers rock 
720p or 1080p displays, 
according to the Steam 
hardware survey. 
Mainstream graphics 
cards are a big deal.

Case in point: Just last 
month, Nvidia released a 
new GeForce GTX 950 
graphics card in order to snatch the $150 crown away 
from AMD’s Radeon R7 370. That prompted AMD to release a more 
powerful R9 370X in some parts of the world.

The tables turn when you hit the $200 mark. First revealed at E3, the 
Radeon R9 380’s “Tonga” graphics processor is the same one found in 







the R9 285, which first launched in August 2014. But don’t let the 
rehashed GPU dissuade you: The Radeon R9 380 is loaded with 
support for AMD’s newest features and delivers the best raw perfor-
mance you can find for $200 today, surpassing Nvidia’s $200 GeForce 
GTX 960—albeit at the expense of much higher power usage.

Meet the new mainstream 1080p champion. Let’s dig in.

Inside the Radeon R9 380
You won’t find much new inside the R9 380 that wasn’t already 

available in the R9 285. Glancing over the spec sheet below, the only 
noticeable difference between the two is that the max clock speed 
was nudged up from 918MHz in the R9 285 to 970MHz in the “new” 
R9 380. The memory speed also received a borderline-negligible 
100MHz bump.

Because of that, we won’t spend much time detailing the Radeon R9 
380’s deepest, darkest details—just check the chart on the next page 
if you're interested. It’s available in models with 2GB or 4GB of 
memory, and since the Tonga GPU is still relatively new—August 2014 
wasn’t that long ago—the R9 380 packs full support for DirectX 12 and 
helpful AMD features like FreeSync, Virtual Super Resolution, and 
Frame Rate Target Control, unlike the $150-and-up Radeon R7 370, 
which is based on a GPU from 2012.
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VisionTek’s 
Radeon R9 380 
backplate.





VisionTek kindly sent us one of its 2GB R9 380s for testing, and you 
couldn’t ask for a better representative. The  VisionTek Radeon R9 380 
(go.pcworld.com/visiontekr9380) sticks to stock specs from clock 
speeds to memory configuration, but spruces things up with a nice 
dual-fan custom cooling solution featuring a card-length heat sink and 
copper heat pipes. Those heat sink fins run across the length of the 
card to help vent heat out of the rear more easily, a design feature 
that AMD itself recently crowed about when introducing the Radeon 
R9 Nano.

A rigid, black metal backplate—shown on the previous page—is 
another nice touch, as is VisionTek’s limited lifetime warranty on the 

Tech specs for the 
entire Radeon R300 
series family.
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card if you register it within 30 
days of purchase. That drops 
to one year if you don’t 
register. The killer 
warranty and 
thoughtful build 
quality isn't free, 
however, as VisionTek 
charges $230 for this 
particular card.

Connectivity-wise, 
the VisionTek 
Radeon R9 380 offers 
DVI-D, DVI-I, HDMI 1.4a, and DisplayPort, the last of which is a must-
have if you’re thinking of investing in a FreeSync monitor to make your 
PC games super-smooth. 

As ever, we tested the VisionTek Radeon R9 380 on PCWorld’s 
dedicated graphics card benchmark system. See the benchmark 
results at go.pcworld.com/visiontekr9380tests.

Bottom line: The new 1080p champ
Add it all up and there’s only one conclusion to reach: Despite the 
higher power draw, the Radeon R9 380 is clearly the best graphics card 
for the money in the $200 price range. It consistently out-performs 
the heavily overclocked GTX 960 SSC in everything but GTA V, though 
Nvidia’s card hangs closely enough to be tempting if the R9 380’s 
power draw is a concern, or if you’re building a home theater PC and 
need an HDMI 2.0 port to output a 60Hz signal to a 4K TV. (The GTX 
950 supports HDMI 2.0; the Radeon R9 380 is limited to HDMI 1.4a’s 
30Hz at 4K.)

For your money, you’ll get a mostly uncompromising mainstream 
1080p gaming experience, hovering around 60fps at Ultra settings in 
many cases, though you may need to tone down some of the more 
extreme anti-aliasing options or set the graphics options to High in 

The VisionTek 

Radeon R9 

380’s port 

selection.





some of most strenuous titles—
but only if the 60fps barrier is 
sacrosanct to you. If you’re fine 
with a console-quality 30fps, the 
VisionTek Radeon R9 380 never 
faltered below that mark, even 
with all the bells and whistles 
enabled in the most strenuous 
games.

But if console-quality graphics 
aren’t a bother, you can save 
some money by dropping down 
to the $150-$170 price range, where the tables turn and 
Nvidia’s GeForce GTX 950 reigns supreme. Graphics cards 
in that range can hit 40fps-plus at 1080p on High graphics 
settings.

For most people, we’d recommend saving your pennies 
for a few weeks more and stepping up to the $200 price 
range. The leap in graphics performance is massive, 
delivering a much more compelling 1080p gaming 
experience for a price that still won’t break the bank. It’s 
crazy how much performance you can get for $200 these days 
(though the R9 380 is not an upgrade from the older R9 280 and 280X, 
which were priced higher).

When Nvidia’s GeForce GTX 960 made its debut, we said that AMD 
needed to drop the Radeon R9 285’s price to $200 to remain 
competitive. With the Radeon R9 380, AMD did just that—and the 
little bit of extra oomph in the card’s clock speeds help make AMD’s 
offering the most enticing for mainstream gamers today.

As far the specific vendor implementation goes, the VisionTek 
Radeon R9 380’s stock-clocked offering may not push the envelope as 
fiercely as some other custom-cooled designs on the market, but the 
overall package is very clean and competent indeed, and that limited 
lifetime warranty is pretty darn enticing.  

We’d recommend 
saving your 
pennies for a few 
weeks more and 
stepping up to the 
$200 price range.



This chip arrived already obsolete, but benchmarks comparing it to 
Haswell and AMD Godavari show its true colors. 
BY GORDON MAH UNG

Intel Core i7-5775C: 
The unwanted desktop 
Broadwell has one neat trick
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THE NARRATIVE IS already in place on Intel’s new Broadwell for 
desktop CPU: It’s the chip no one wanted.

As someone who watched this story unfold, I know the truth is 
actually the opposite. You see, Intel’s 3.3GHz Core i7-5775C is actually 
something the Internet demanded.

Remember that in 2012, the Internet said Intel would effectively “kill 
the desktop” PC because the company had no plans for a socketed 
CPU past Haswell.

The truth is, Broadwell was always intended as a lower-power part 
with no practical appeal outside of laptops, NUC-style computers and 
all-in-one PCs. Instead, Intel told me at the time, desktop sockets will 
get a workout with the next big thing: Skylake.

Anger and hand-wringing ensued. Soon, bowing to pressure from its 
die-hard desktop community and PC vendors, Intel rolled over and 
decided to make a socketed version of Broadwell.

That brings us to the new Core i7-5775C—the CPU Intel never 
wanted. Now it looks like not even the crowd that demanded the chip 
will want it. 

What Broadwell is
Intel announced 10 Broadwell CPUs in June at Computex. Half will go 
into laptops, and another three will be soldered on motherboards in 
all-in-one or Mini PCs, as Intel originally planned. But of those 10, two 
will fit into the traditional socket that desktop users want. That’s what 

Intel’s Broadwell 
flanked by a Haswell, 
Sandy Bridge, and 
massive Haswell-E 
chip.
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I’m looking at today.
The Core i7-5775C will work in most 9-series motherboards and 

systems out there with BIOS support. Just be advised, that’s not 
exactly straightforward. To get my Core i7-5775C up and running, I 
didn’t just have to update the BIOS; I had to update it the right way. 
Check with your motherboard maker if you plan to go with a 
Broadwell C part.

Broadwell is a 14nm-process CPU that should offer a 5-percent or so 
performance increase over Intel’s 4th-generation Haswell CPUs, if all 
things were even. My own tests of Haswell vs. Broadwell (go.pcworld.
com/hvb) mobile parts confirmed that. 

Everything isn’t even, though. The pair of Broadwell C chips Intel has 
produced feature a massive 128MB of Level 4 (L4) cache using 

Here’s Intel’s new Broadwell quad-core team. The HQ denotes mobile CPUs, the R chips will go into 

all-in-one, and the C chips are socketed.

Processor 
Number Cores/Threads

Base Freq 
(GHz) Graphics Price L3 Cache TDP

i7-5950HQ 4/8 2.9 Intel  Iris Pro 
graphics 6200

$623 6M 47W

i7-5850HQ 4/8 2.7 Intel  Iris Pro 
graphics 6200

$434 6M 47W

i7-5750HQ 4/8 2.5 Intel  Iris Pro 
graphics 6200

$434 6M 47W

i7-5700HQ 4/8 2.7 Intel  Iris Pro 
graphics 5600

$378 6M 47W

i5-5350H 2/4 3.0 Intel  Iris Pro 
graphics 6200

$289 4MB 47W

i7-5775C 4/8 3.3 Intel  Iris Pro 
graphics 6200

$366 6M 65W

i7-5775R 4/8 3.3 Intel  Iris Pro 
graphics 6200

$348 6M 65W

i5-5675C 4/4 3.1 Intel  Iris Pro 
graphics 6200

$276 4M 65W

i5-5675R 4/4 3.1 Intel  Iris Pro 
graphics 6200

$265 4M 65W

i5-5575R 4/4 2.8 Intel  Iris Pro 
graphics 6200

$244 4M 65W





embedded DRAM. This cache 
is slower than the cache 
integrated into the CPU itself 
,but because it’s actually a 
chip sitting next to the CPU 
and wired directly to it, it’s a 
magnitude faster than using 
system RAM.

This isn’t a new trick. Intel 
actually sold three Haswell 
CPUs with a similar 128MB L4 
cache aboard. Those CPUs were available only in NUC-style machines 
like the Gigabyte Brix Pro (go.pcworld.com/gbrix) and soldered down 
to the motherboard. Like the Broadwell desktop chip, the eDRAM’s 
existence is mostly to address graphics performance, where memory 
bandwidth is king.

How we tested
For my test, I used an Asus Z97-Deluxe motherboard with 16GB of 
DDR3/1600 and 240GB SSD. I updated the motherboard to the latest 
UEFI available, installed a fresh copy of 64-bit Windows 8 and hunted 
down the latest drivers as well. Because the graphics capability of the 
the Broadwell C is a driving feature, I tested it without a discrete GPU.

I realize that decision doesn’t track with what most people are doing 
with these expensive CPUs. I’d bet it’s close to 90 percent who pair 
higher-end CPUs with graphics cards for gaming. Still, the graphics 
performance of these chips is a very important feature.

The competitor was a natural choice: Intel’s Core i7-4790K, aka 
Devil’s Canyon. 

The Core i7-4790K has a clock speed of 4GHz and will Turbo Boost up to 
4.4GHz on some loads. It has Intel HD4600 graphics and on the street 
sells for $340. For more details, I’ve lined both them up (go.pcworld.com/
compare) at Intel’s ARK website. It’s pretty much the pinnacle of quad-
core Haswell performance.

Although this 
chip isn’t a 
socketed 
version, it gives 
you an idea of 
what Broadwell 
C looks like. The 
chip in the 
center is the 
CPU while the 
chip on the 
right is the 
128MB of 
eDRAM cache.
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Besides the Broadwell to Haswell generation difference, the other 
factor that matters here is the clock speeds between the two 
chips. The Broadwell Core i7-5775C has a base clock of 3.3GHz with a 
Turbo Boost of 3.7GHz. 

Encoding
The first test we can discuss is our Handbrake workload. We use the 
free and popular Handbrake encoder to convert a massive 30GB MKV 
file into a much more compact MP4 file using the Android Tablet 
preset. Notes: Our normal system review benchmark uses the 0.9.9 
version but for this, I wanted to use the latest version of Handbrake 
0.10.2. Because it does effect the encoding time, you can’t compare 
results between the versions. Handbrake allows you to choose 

Handbrake  0.10.2 x 264 encode (sec)

Core i-C

Core i-K

0 1,500 3,0002,500 3,5002,0001,000

SHORTER BARS INDICATE HIGHER PERFORMANCE

500

2,963

2,241

Handbrake  0.10.2 QuickSync encode (sec)

Core i-C

Core i-K

0 1,000800 1,200600400

SHORTER BARS INDICATE HIGHER PERFORMANCE

200

793

958

Handbrake when 
confined to the 
x86 cores in the 
CPUs favors the 
higher-clocked 
Haswell chip over 
Broadwell.

As Madden says: 
Boom. Quick Sync 
on the Broadwell 
C stomps the 
higher-clocked 
Haswell CPU.





different encoders so for the first one, I used x264, which is heavily 
multi-threaded and keeps the workload to the x86 cores in the CPU.

The result was a big win for the Core i7-4790K and clock speed in 
general. 

But wait, encoding video isn’t done just on the x86 side anymore. 
Today, encoding on the GPU is the way to go for performance, and 
Intel has dedicated transistors for hardware encoding into its chips, 
called Quick Sync. What happens when we give Handbrake the same 
task, but using the graphics cores instead?

Boom: The improved Broadwell graphics cores combined with its 
massive eDRAM flips this battle on its back. Besides whistling at how 
much of a recovery the Core i7-5775C made here, you should also take 
note of the encoding time it took using the GPU cores rather than the 
x86 cores in the CPUs. The Core i7-5775C, for instance, takes a third of 
the time to get the work done. There are arguments that GPU 
encoding leads to visual impurities, but when you’re crunching a file 
down to watch on your phone, who cares?

3D rendering
Next up, we used Cinebench R15, a test based on Maxon’s Cinema 4D 
animation package. It’s a great benchmark that is pure CPU and 
heavily multi-threaded. The result is no surprise, as 3.7GHz even with 
the newer Broadwell cores can’t beat 4.4GHz. 

CineBench R15 All Cores

Core i-C

Core i-K

0 700600 800400300

LONGER BARS INDICATE HIGHER PERFORMANCE

100 200 500 900

687

875

Clock speed 
wins. Again.





Work performance
Our next test is PCMark 8, which simulates various computing tasks 
broken down into Work, Home and Creative categories. Work 
measures general Office Drone tasks, Creative throws in photo, video 
and light gaming, while Home factors in more casual gaming. 

The first result is from PCMark 8 Work Conventional. Again, the Core 
i7-5775C's lack of clock speed shows even on these basic tasks that a 
Celeron could run.

Creative performance
Once PCMark 8 mixes gaming performance into this test, the 
Broadwell makes a nice comeback. The result is similar in the PCMark 8 
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PCMark 8 Work Conventional

Core i-C

Core i-K

0 3,5003,000 4,0002,0001.500

LONGER BARS INDICATE HIGHER PERFORMANCE

500 1,000 2,500 4,500

3,518

3,919

PCMark 8 Work 
Conventional 
measures 
simulated Office 
Drone 
performance.

4,0003,000 3,5002,0001.5001,000 2,500

PCMark 8 Creative Conventional

Core i-C

Core i-K

0

LONGER BARS INDICATE HIGHER PERFORMANCE

500

3,804

3,778

PCMark 8 Creative 
Conventional adds 
video and photo 
editing into the 
test load.





Home test, which adds gaming into the mix and puts the Broadwell in 
a much better light than the Haswell, thanks to its better gaming 
capability.

Chess performance
The Fritz 12 Chessbenchmark measures a CPU’s ability to calculate 
chess moves. The yard stick is a 1GHz Pentium III. A score of 10 would 
mean the tested CPU is 10 times faster than a 1GHz Pentium III 
performing the same tasks. The results again don’t look great for the 
Broadwell desktop part. Even though we know Broadwell’s cores are 

maybe 5 percent more efficient doing the same task, it’s not enough 
to compensate for the higher clock speeds of the Core i7-4790K chip.

Where Broadwell really shines
On the compute side, the Broadwell desktop part can’t hang with the 
higher clock speeds of the Haswell chip but what happens when the 
GPU is the primary driver of the task? It’s a different situation.

For reference, I’m going to toss in the brand-new “Godavari” AMD 
A10-7870K chip. It’s technically a 12-core CPU by AMD’s standards, but 
that really means it’s a quad-core CPU with eight GPU cores in it. The 
x86 cores run at 3.9GHz to 4.1GHz, and the integrated Radeon R7 
graphics cores buzz along at 866MHz. 

While AMD’s x86 performance has been weak sauce these last few 

Fritz Chess Benchmark

Core i-C

Core i-K

0.0 30.0 35.020.015.0

LONGER BARS INDICATE HIGHER PERFORMANCE

5.0 10.0 25.0 40.0

27.8

35.5

The Fritz chess 
benchmark 
measures how 
fast a CPU is at 
calculating chess 
moves. Each of 
those “units” is 
the performance 
of a 1GHz 
Pentium III.





years, the graphics performance has rained pain on Intel’s just as 
badly. The best part of AMD’s Godavari is its price. It’s a chip with a 
$137 list price, but it’s actually selling for more, at $149. That’s less 
than half of either Intel CPUs. Some may cry foul at using the Godavari 
because it’s so much cheaper, but I think it’s fair to put the APU’s 
graphics performance in context.

Note: I tested the A10-7870K with its RAM set to DDR3/1600 to 
match the Intel systems and also grabbed the latest Catalyst driver 
available.

Synthetic gaming performance
First up is the popular 3DMark. This is a great showing for the Core 
i7-5775C Broadwell chip when compared to the Core i7-4790K Haswell 
chip and shows just how far Intel has come. In fact, Intel has always 
said Broadwell was a minor tick in performance on the x86 side, but its 
graphics performance was a major tock. Helped by the eDRAM in the 
chip, that seems to be true. Intel has finally caught up with AMD’s 
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Broadwell for desktop 
fits into existing Z97 
motherboards. 





integrated graphics performance. Of course, there is that price 
discrepancy between the AMD and Intel chip to consider. 

Firestrike is a little over the true capability of these CPUs so I also ran 
the easier Sky Driver test. Interestingly, the Core i7-5775C starts to 
pull away from the AMD A10-7870K in the overall score. That’s likely 
due to the more efficient Intel cores, boosting its final scores higher. 

Dirt Showdown
Enough with the synthetic tests. To see how the integrated graphics 
would perform in actual games, I threw Code Master’s Dirt Showdown 
at all three. The result is a huge win for the Broadwell desktop chip. 

3DMark Firestrike Graphics

Core i-C

LONGER BARS INDICATE HIGHER PERFORMANCE

0 1,200 1,400800600200 400 1,000 1,600

1,489

A-K 1,480

Core i-K 851

In 3DMark, AMD’s 
best APU has met 
its match. Too 
bad it cost more 
than twice as 
much.

3DMark Sky Diver Overall

Core i-C

LONGER BARS INDICATE HIGHER PERFORMANCE

0 5,000 6,0003,0001,000 2,000 4,000 7,000

5,925

A-K 5,695

Core i-K 3,776

3DMark’s Sky 
Diver is better 
suited for the 
integrated 
graphics 
performance in 
these CPUs.





Dirt Showdown actually runs fairly well at 1920x1080 on all three, too. I 
would never play a first person shooter at 32fps, but in driving games, 
where you don’t whip around like you do in a shooter, it’s surprisingly 
tolerable. 

BioShock Infinite
Moving on to Irrational Games' BioShock Infinite, a lot of visual quality 
settings had to be compromised to get to playable framerates. The 
result is a big win for the Core i7-5775C again. It leaves the AMD APU 
in the dust, and its sibling is a very distant third. If I were really 
attempting to play BioShock Infinite on integrated graphics, I’d notch it 
down to 1366x768 to get the frame rates higher. 

Tomb Raider
The last game I ran was Square ENIX’s Tomb Raider. Like the other 
games, it shines on the Core i7-5775C chip. At 1920x1080 resolution, 
the Broadwell chip can even run it at the magical 60+ frames per 
second. You make a lot of compromises in visual quality, though. I’d 
personally run it at 1366x768 at normal quality, where the game looks 
much better and the Broadwell can push 72 fps. The AMD A10-7870K 
interestingly takes a back seat to even the Core i7-4790K here. That 

In a real game, 
the new 
Broadwell Core 
i7-5775C pulls 
away from the 
pack.

Dirt Showdown 19x10 medium quality (fps)

Core i-C

LONGER BARS INDICATE HIGHER PERFORMANCE
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may indicate Tomb Raider's dependence on the x86-side, and the 
AMD’s chips weaker cores dragging it down a little. 

OpenCL performance
The final graphics test I ran was Luxmark 3.0, a benchmark that 
measures OpenCL performance. OpenCL is a way to run general 
computing tasks on a graphics chip. The story is the same: the Core 
i7-5775C clocks the other two CPUs by a healthy margin.

The actual surprise is the A10-7870K, which loses badly to the Core 
i7-4790K chip. I didn’t expect the Godavari to ace the Broadwell and 

Tomb Raider 19x10 low quality (fps)
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BioShock Infinite 19x10 low quality (fps)
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Bioshock Infinite 
isn’t really 
playable at 
1920x1080 on 
any of the CPUs.
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its big cache, but losing to the Haswell chip was a surprise.

Conclusion
There’s no way to talk about the Broadwell socketed chip without 
talking about: Skylake. Intel’s next desktop chip is shipping this fall, 
and Skylake is the rightful successor to Haswell. So why even waste 
time with Broadwell?

After all of my testing, I think that conclusion is probably the right 
one. If Broadwell in a socket had been introduced six months ago, it 
might have had a fighting chance. But now? No.

Skylake introduced a new socket with it. Would anyone in their right 
mind would build or buy a new system using a Broadwell chip?

Even the strongest argument for Broadwell in a socket is very niche. 

In general use, it’s actually slower than the cheaper Haswell chip.
Broadwell’s strongest point is actually as an integrated graphics chip. 

With its embedded DRAM it smokes all other integrated graphics you 
can buy today by a huge margin. It’s actually capable of playing some 
games at 1920x1080 at the magical 60+ fps frame rate at lowered 
image quality settings, which is amazing for integrated graphics.

But who spends $366 on a CPU to play games without a graphics 
card? As good as the Core i7-5775C is for an integrated graphics chip, 
a $150 GPU would run circles around it. Take that $150 GPU and pair it 

Luxmark 3.0 Luxball GPU only 

Core i-C

LONGER BARS INDICATE HIGHER PERFORMANCE

0 2,500 3,000500 1,500 2,000

AMD 
A-K

Core i-K
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Luxmark 3.0 is an 
OpenCL test and 
oddly, the AMD 
part gets burned 
by even the 
Haswell chip.





with a $200 Core i5, and you’d get better gaming results.
You may certainly make some arguments that its best use would be in a 

space-constrained mini system or All-in-One PC but that’s the perfect 
place for a soldered version of the chip, not a socketed version.

That’s also just like Intel originally planned.  

Broadwell is destined 
to live deep in the 
shadows of Intel’s 
upcoming Skylake CPU.



Children are our greatest hope for the future. 
Let’s be their greatest hope too.

Cancer strikes infants and children. For teens 
and young adults, survival can depend on 
treatment by a pediatric oncologist, designed 
specifically for them.

The St. Baldrick’s Foundation and Stand Up To 
Cancer are funding groundbreaking collaborative 
research to bring the most effective therapies to kids 
fi ghting cancer. To learn how you can help keep 
these kids in play, go to stbaldricks.org/inplay and 
standup2cancer.org/pediatrics.

175,000 KIDS WILL BE
       DIAGNOSED WITH 
       CANCER THIS YEAR.

HELP KEEP 
THESE KIDS

IN PLAY.

Julia Hernandez
Diagnosed at 16, 
in remission. Samuel L. Jackson

Stand Up To Cancer and 
St. Baldrick’s Ambassador 

St. Baldrick’s Foundation is a charitable 501(c)(3) organization funding childhood cancer research. 
Stand Up To Cancer is a program of the Entertainment Industry Foundation, a 501(c )(3) charitable organization. Ph
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Windows 10 is chock full of handy, 
hidden new features worth exploring. 

Check out the best tips and tricks here.

FEATURES      





W indows 10, Micro-

soft’s back-to-basics 

re-embracing of the 

PC, is already brim-

ming with handy new features (go.pcworld.

com/w10first10), and with all the new good-

ies comes with a legion of new tweaks and 

tricks—some of which unlock powerful func-

tionality hidden to everyday users.

Others, though, simply let you mold some 

of Windows 10’s new features into the shape 

you see fit. Here are some of the most use-

ful Windows 10 tweaks, tricks, and tips we’ve 

found. Be warned: Some of these may break 

as the operating system evolves, given Micro-

soft’s new “Windows as a service” mentality.
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Cortana’s finally 
made the leap to 
the PC in
Windows 10,
assuming control 
of the operating
system’s search 
functions and
dishing out just as
much sass (go.
pcworld.com/
w10cortanaeggs) 
as the Windows 
Phone version. 
But by default,
she doesn’t listen for your commands.

If you’d like to be able to just bark commands
at your PC, open Cortana by clicking the search
field in the taskbar and select the Notebook 
icon in the left-side options pane. Select
Settings from the list, then simply enable the
“Let Cortana respond when you say ‘Hey 
Cortana’” option. You’ll need an active
microphone for this to work, of course.

While you’re poking around Cortana’s 
options, you can dive into the Notebook menu
to fine-tune exactly what personal data
Microsoft’s digital assistant can access. 
Remember, however, that like Google Now,
Cortana’s effectiveness is directly related to
how much she knows about you.

Powerful natural 
language search
Cortana can handle all sorts of 
commands you issue using 
natural language, such as 
playing music, creating 
reminders, or showing you the 
weather, but the most 
powerful use of her natural 
language abilities revolves 
around basic search 
capabilities. You can give 
Cortana basic commands like 
“Find pictures from June” or 
“Find documents with 
Windows 10” and she’ll apply 
the appropriate filters, then 
scour your local files and 
OneDrive storage for results.





Customize your Start menu
Don’t forget to make the Start menu your own. If 
you appreciate the blend of the traditional 
interface with the Live Tiles, note that you can 
right-click on any tile and select Resize to alter 
the tile’s dimensions—just like on the Windows 8 
Start screen.

Alternatively, if you loathe Live Tiles and the 
Metro interface with the ferocity of a thousand 
suns, you can also right-click on every one of the 
defaults in the Start menu and select Uninstall to 
wipe them from your system. (Or simply Unpin from 

Start if you’d rather hide than eradicate them.) Repopulate them with desktop software of 
your choosing—you can right-click any app or program and select Pin to Start—and before 
you know it, it’ll be kind-of-sort-of like the Windows 7 Start menu all over again.

MAKE MAIL  
YOUR OWN
Windows 10’s overhauled Mail and 
Calendar apps rock compared to 
Windows 8’s lackluster offerings. 
They’re lightning fast, more full-
featured, and infinitely more mouse-
friendly than before.

Even better, the new Mail adds 
customization options that let you put 
a personal touch on the app. Not only 
can you change the image in the 
preview pane with the picture of your 
choice, but you can also configure how 
Mail behaves when you perform on of 

its new swipe gestures on a message.
To start tinkering, click the cog icon 

in the lower-left corner of the app, then 
select Options. Wah-lah! You’ll find all 
the gesture options in the Quick Actions 
portion.
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When you open File Explorer in Windows 10, it 
defaults to a new Quick Access view that shows
your most frequently accessed folders and 
recently viewed files. I love it, personally, but if 
you’d rather File Explorer defaulted to the “This 
PC” view found in Windows 8, here’s how.

Open File Explorer, then select View > Options from the Ribbon. A Folder
Options window will open. Click the “Open File Explorer” drop-down menu
at top, then select the “This PC” option. Click OK and you’re done!

Move open 
windows between 
virtual desktops
Virtual desktops let you segregate 
your open apps into discrete areas—
literally multiple, virtualized versions 
of your PC’s desktops. Switching 
between open virtual desktops is 

easy enough using Task View (the button that looks like two panels, one over the 
other, in the taskbard) or Windows key + Tab, while Alt + Tab jumps you between 
open apps across all desktops. There’s also a way to actually shift an open app from 
one virtual desktop to another if you’d like to shuffle things around.

First, head to the virtual desktop housing the app you’d like to move to another 
virtual desktop, then open the Task View interface. Just click-and-hold on the app 
you’d like to move, then drag it to the desired virtual desktop at the bottom of the 
screen. You can also drag it to the “+New Desktop” option in the lower-right corner 
to create a new virtual desktop for the app.





Schedule your 
restarts
This is wonderful. If you’ve got 
pending updates that require you 
to reboot your PC, Windows 10 will 
allow you to schedule a specific 
time for it to do so. Finally!

Open the Settings option in the 
Start menu, then head to Updates 
and Recovery > Windows Update. 
If you have an update pending, 
you’ll see the screen at left, which 
lets you schedule your reboot 
after you select the “Select a 
restart time” radio button. Even 
better, you can dive into the 
Advanced options and link and ask 
Windows to notify you to schedule 
a reboot whenever updates are 
ready to rock.

But the Windows Update upgrades don’t end
there. Windows 10 introduces a new option 
that lets you download updates using peer-
to-peer technology, rather than Microsoft 
directly. It could help you get that hot 
security patch faster when everybody’s 
hammering Microsoft’s dedicated servers, or
save you bandwidth in a computer-crowded
house—just download the new patch once 
from Microsoft, then share it among the PCs 
under your care.

To tinker with the setting, head to Settings 
> Update & Recovery > Windows Update > 
Advanced Options > Choose how you 
download updates. By default, “Get updates 
from more than one place” is enabled and
configured to grab updates from PCs on both 
your local network and the Internet at large.
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Windows 10 packs a slew of 
nifty new command line
features, including—
hallelujah!—the ability to
copy and paste inside the command prompt with Crtl + C and Crtl + V.

To activate the goodies, open the command prompt. Right-click its 
title bar, then select Properties. You can find and enable the new features 
under the “Edit Options” section of the Options tab.

Record a video  
of an app
Windows 10’s new Game DVR function 
is supposed to be used for recording 
video evidence of your most glorious 
gaming moments, but it’ll actually let 
you create videos of any open app or 
desktop software (though not OS-level 
areas like File Explorer or the desktop).

To summon it, simply press Windows 
key + G. A prompt will ask you if you want to open the Game bar. Lie your butt off and 
click the “Yes, this is a game box” and various options will appear in a floating bar. Simply 
click the circular Record button to capture a video. You can find your saved videos in the 
Game DVR section of the Xbox app, or inside your user folder under Video > Captures.





Fresh 
keyboard 
shortcuts!
Windows 10 packs a 
handful of fresh 
keyboard shortcuts, all 
tied to newfound 
abilities inside the 
revamped operating 
system. There are 
many more than we 
can list here, so head 
over to PCWorld’s 
guide to Windows 10’s 
keyboard shortcuts 
(go.pcworld.com/
w10keycuts) to learn 
all about them.

GODMODE
The legendary GodMode, a hidden staple for 
Windows power users, makes its return in Windows 
10 (go.pcworld.com/w10godmode). As before, 
activating it unveils a power user menu that brings 
together all of your system’s far-flung settings and 
configuration options into a single location. Just 
create a new folder and rename it to following:

GodMode.{ED7BA470-8E54-465E-825C-
99712043E01C}

Don’t forget the period after “GodMode”, and you 
can rename the “GodMode” portion whatever you’d 
like if you want another name for the folder.





FEATURES      WINDOWS  TIPS

After being banished to the 
Windows Store in Windows 8, 
Solitaire is back in Windows 10, 
baby. But it can be tricky to find.

Solitaire’s not in the Start
menu, and its old Start > 
Programs> Accessories > 
Games stomping grounds 
aren’t found in Windows 10. 
Looking for Solitaire in the All 

Apps section of the Start menu is also a fruitless endeavor—but that’s because the 
game’s officially called “Microsoft Solitaire Collection Preview.” You can find that in All 
Apps, or just search for Solitaire. It’ll pop right up.

Enjoy!

SOS!
Did you break something in 
Windows 10 or one of your 
Microsoft apps? Don’t sweat it—
help is just a few clicks away.

Just look for the new Contact 
Support app inside the All Apps 
menu. It can point you towards the 
appropriate community forums to 
find help for the issue, or even 
connect you with a Microsoft 
support representative via online 
chat or phone if you stumble into a 
particularly bad problem.





Offline Maps
Speaking of apps, the revamped 
universal Maps app, like any maps tool 
worth using (and unlike the Windows 8 
Maps app), packs an offline maps 
feature. Click the Settings (gear) icon in 
Maps, then select Download or update 
maps under the “Offline maps” header.

You’ll be bounced to the Settings 
app, where you’ll be able to select 
which continent, then country whose 

offline map you’d like to download. (If you’re downloading a U.S. map, you’ll also have to 
select which state you need.) Helpfully, Windows tells you how large the download will 
be before you start scraping the maps.

CHAMELEON
The customization doesn’t 
end there. Windows 10 offers 
you more granular control 
over the color of your taskbar, 
Start menu, and search field.

Open the Start menu and 
head to Settings > 
Personalization > Colors to 
start tweaking things. The 
“Automatically pick a color 
from my background” option does what it claims, then applies that color to the 
Cortana/search field and underneath the icons of open apps. “Show color on taskbar 
and Start menu” also does just that, while disabling “Make Start menu transparent”—
which is enabled by default—removes the subtle see-through effect in favor of a full-
blown opaque background for both the Start menu and the taskbar.
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ENABLE TABLET MODE
Windows 10’s Continuum, which dynamically switches from the traditional desktop to 
a more Metro-like interface when you’re using a touchscreen, is supposed to kick into 
action when you connect or disconnect a keyboard from your Windows hybrid or 
tablet. But what if you’re using a standard PC and just plain love full-screen apps and 
the Live-Tile-strewn Start screen, rather than the Start menu?

Easy! Activate Tablet Mode. Open up Windows 10’s new Action Center—the small 
icon that looks like a comic-book word bubble in your system tray—and click the Tablet 
Mode button. Everything will be removed from your desktop, save for spaced-out icons 
for the Start button, Cortana, and Task View. (Want your open and pinned apps to stay 
on the taskbar? The option’s found in Tablet Mode settings, which we cover later.) Now 
press the Start button to bask in the full-screen apps and Start screen, since that’s 
obviously your thing.





Tinker with Tablet Mode
But what if you don’t want to fuss 
with all that manual Tablet Mode 
labor? While Windows 10 should 
intelligently switch between the two 
when you’re using a hybrid, you can 
also tweak how the operating system 
handles Continuum.

Simply search for “Tablet Mode” 
and select the “Tablet Mode Settings” 
option that appears. Here, you’ll be able to tell Windows whether you want to even use 
Tablet Mode on this device, and specify how you want to handle Tablet Mode prompts if 
so. You can also tell Windows to keep your open and pinned apps on the taskbar when in 
Tablet Mode if you so desire, as well as to boot into tablet mode at startup.

GET RID OF THE 
OLD STUFF
When you upgrade to Windows 10 over an 
existing Windows 7 or 8 installation, it 
keeps a copy of your old operating system 
around in a folder dubbed Windows.old 
just case you need to revert back for any 
reason. If you know you’re never going 
back you can delete that folder to reclaim 
the lost gigabytes—but it’s not as simple 
as right-clicking on it and selecting Delete.

Search for “Free up disk space by 
deleting unnecessary files”. Click the shortcut, select your primary hard drive (if you 
have multiple installed), and in the window that appears, click “Clean up system 
files.” After Windows thinks for a second, check the “Previous Windows 
installations” box in the list, then click OK and confirm you want to delete the files.
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System-wide notifications were a 
highlight feature for Windows Store 
apps in Windows 8, and Windows 10’s 
new Action Center lets you actually 
manage them, making notifications 
useful rather than one-off shouts into
the wind.

You might not want every Windows
Store app you install barking at you all the 
time, however, or maybe you don’t want 
to see any notifications while you’re in
presentation mode. To tinker with you your notification settings, head to Start menu >
Settings > Systems > Notifications and actions. Individual Windows Store apps tend to
have more granular notification options in the Settings menus inside the apps themselves.

Edge’s reading 
enhancements
Windows 10’s new Edge browser drags 
Microsoft’s web efforts into the modern era, with 
a blazing fast engine and nifty forward-thinking 
tricks like intelligent, automatic Cortana 
integration for supplementing the info you’re 

looking at. But to me, the most refreshing aspects of Edge are its reader-first extras, 
which carry over from Windows 8’s Metro IE app: Reading View and Reading List.

Reading View (the small book icon, next to the bookmark star in the browser 
bar) strips away ads, sidebar images, and other clutter to present a clean, 
straightforward reading experience. Edge also supports sharing to the Reading List 
app, which functions like Pocket or Instapaper, essentially letting you a story for 
later reading. To save a juicy article, simply click the bookmark star and opt to save 
the article to your Reading List rather than as a bookmark.





The Safeway Foundation and the Entertainment Industry Foundation are 501(c)(3) tax-exempt organizations. Photo by: Nigel Parry

The Hunger Is campaign is a collaboration between The  
Safeway Foundation and the Entertainment Industry Foundation  
to raise awareness and improve the health of hungry children.
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Windows 10 has a bunch of new features 

that bring new keyboard shortcuts along 

with them. Here’s a list of the best keyboard 

shortcuts to know to make your time with 

Windows 10 more efficient. By Ian Paul





With Windows 10, Microsoft has added a ton of 

new keyboard shortcuts to give you easier access 

to the new Action Center, Cortana, Task View, 

and virtual desktops. So much so, in fact, that Microsoft recently 

released a handy-dandy Word document with Windows 10’s 

Windows key shortcuts to aid in your study.

If you’re new to keyboard shortcuts, however, one glance at 

that list can be overwhelming—and there are plenty of 

keyboard shortcuts that don’t involve the Windows key 

whatsoever. To help you streamline it a bit, here’s a list of 20 

must-know shortcuts for Windows 10. 

This isn’t just a list for Windows 10, however. Many of these 

shortcuts work with older versions of Windows, and you’ll find a 

few standard browser shortcuts as well. If you’re on Windows 7 

or 8.1 but new to shortcuts this list will also help you take 

control of your Windows machine and make you more efficient 

by lessening your dependence on the mouse.
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+ A + TAB

+ I +

+

+

+

+

+

D

+ C

+ S

WINDOWS  10’s  
NEWEST  FEATURES
OPEN THE 
ACTION CENTER

OPEN  
TASK VIEW

OPEN THE 
SETTINGS APP

CREATE A NEW 
VIRTUAL DESKTOP

CLOSE THE  
CURRENT DESKTOP

SWITCH BETWEEN  
VIRTUAL DESKTOPS

LAUNCH CORTANA  
IN LISTENING MODE

LAUNCH  
CORTANA

CTRL

CTRL

CTRL

F4

→
OR
←





+

+ E +

+

X

+ L

+ PRT 
SCN

STANDARD  
WINDOWS  SHORTCUTS
OPEN/CLOSE THE 
START MENU

OPEN/CLOSE THE START BUTTON’S 
RIGHTCLICK CONTEXT MENU

LAUNCH  
FILE EXPLORER

SNAP CURRENT WINDOW TO 
RIGHT OR LEFT OF SCREEN

TAKE A SCREENSHOT OF CURRENT  
WINDOW & COPY IT TO YOUR CLIPBOARD

LOCK THE  
DESKTOP

TAKE A SCREENSHOT OF ENTIRE DISPLAY AND 
SAVE TO COMPUTER > PICTURES > SCREENSHOTS

PRT 
SCN

→
OR
←

WINDOWS 7 AND UP

WINDOWS 7 AND UP

WINDOWS 7 AND UP WINDOWS 7 AND UP

WINDOWS 7 AND UP

WINDOWS 8.1 AND 10

WINDOWS 8.1 AND 10

ALT
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++

+ D +

LT

+ ENTER

BROWSER  
SHORTCUTS

OPEN   
NEW TAB

HIGHLIGHT  
CURRENT URL

BOOKMARK 
PAGE

CYCLE THROUGH  
OPEN TABS

ADD “.COM” TO THE END OF A WEB ADDRESS  
E.G. TYPE ‘GOOGLE’ THEN CTRL + ENTER TO GET GOOGLE.COM

CTRL

CTRL

CTRL

CTRL TAB

CTRL

Work in Edge and most other browsers





Ready.gov/business

Up to 40% of businesses never recover after experiencing a major disaster. 
Do you have a plan to keep your business running if disaster strikes?  
For a free online tool that helps you develop an emergency plan,  
visit Ready.gov/business.
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enhanced editions
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these kinds of interactivity and more!

VIDEOS: Tap and play videos 
(with Internet connection).

SLIDESHOWS: Swipe 
image to activate slides.

360-DEGREE VIEWS: 
See products from all angles.





152  4 ways to turn off 
annoying 
notifications  
on your Android 
phone or iPhone

159  Excel logical  
formulas: 5 simple  
IF statements  
to get started

166  Hassle-Free PC 
How to customize 
Windows File 
Explorer’s details 
view 

169  Answer Line 
How to turn off  
Windows 10’s 
keylogger (yes,  
it still has one)

HERE’S 
HOW

CONTENTS





Weed out the random calls, messages, and alerts, and focus only on 
the ones that really matter to you.

How to build, maintain,  
and fix your tech gear.

HERE’S 
HOW

4 ways to turn off annoying 
notifications on your 
Android phone or iPhone

BY BEN PATTERSON





SO THERE YOU are, doing your best to connect with a friend 
over a cup of coffee, and you can’t help but notice the pulsing 
alert on your phone’s touchscreen. What if it’s your babysitter 
trying to reach you, or a nasty email from your boss?

You surreptitiously unlock your phone to see what the fuss is 
about—and just like that, you become one of those people who can’t 
keep their hands off their handsets, even when there’s a flesh-and-
blood person in front of them. (Oh, and that message on the screen? 
It was a promo for a half-off sale. Great.)

The good news is that your Android phone or iPhone boasts a series 
of tools that can help you concentrate on the people who matter, 
rather than being distracted by random calls, messages, and alerts.

Read on for four ways to keep your eyes and hands off your phone, 
starting with…

Let the Do Not Disturb (iOS) and Priority 
(Android) modes screen your calls
Sure, activating Do Not Disturb mode for your iPhone and iPad (tap 
Settings → Do Not Disturb, or tap the Do Not Disturb button from the 
swipe-up Command Center pane) or Priority mode on Android (click 
the volume button, then tap Priority) is a great way to keep your 

You can set “Do 
Not Disturb” and 
“Priority” mode 
(pictured) to 
screen your calls 
and text messages, 
allowing only the 
most important 
ones through.





phone from buzzing during lunch, but you may still find yourself 
tempted to check your messages. After all, what if your spouse is 
trying to reach you—or your irate supervisor, for that matter?

Here’s a trick that’ll help keep your mind on your Caesar salad: just 
set Do Not Disturb or Priority mode to screen your calls and text 
messages, allowing only the most important ones through. That way, 
you’ll be confident that your silent Android phone or iPhone isn’t 
actually ringing off the hook with mission-critical calls, and more likely 
to pay attention during your lunchtime chat.

For Android:
Tap Settings → Sound & Notification → Interruptions, then make sure 
the Calls and Messages switches are toggled on. Next, tap Calls/
Messages and choose the Starred Contacts Only option, then go 
through the Contacts app and star only those contacts who really, 
truly matter to you.

To enable Priority mode, click the volume button to make the 
volume slider appear, then tap Priority.

Finally, sit back and give your full, undivided attention to a (grateful) 
friend.

For iOS:
Tap Settings → Do Not Disturb → Allow Calls From, then pick the Favorites 
setting. Once you do, calls and text messages from those on your iOS 
Favorites list will ring through even with Do Not Disturb mode switched on.

You can also pick a specific contact group for the Allow Calls From 
setting, but you can only set up contact groups using the Mac version 
of the Contacts app. Open the Contacts application on your Mac 
desktop, then click File → New Group to get started. As long as you’re 
syncing your contacts using iCloud, your desktop groups in Contacts 
will sync up with the Contacts iOS app.

You can also enable the Repeated Calls setting, which will allow 
urgent callers to break through Do Not Disturb mode if they call twice 
within three minutes.





Enable VIP alerts for email messages (iOS only)
There’s little chance you’ll get through an important meeting without 
glancing at your iPhone if your screen is constantly flashing with alerts 
for new email messages. Luckily, the iOS Mail app has a feature that 
can ease your email notification overload.

Mail’s VIP alerts give you separate notifications for your most 
important email contacts, perfect for leaving you alone unless a 
message from a close friend or someone in upper management lands 
in your inbox.

Open the Mail app, back up to the main Mailboxes screen, tap the 
VIP mailbox, then tap Add VIP to add a contact to your VIP list. Once 
you’ve added some names to the list, tap VIP Alerts to manage your 
VIP notifications. You could, for example, give messages from VIPs a 
special ringtone or a custom vibration when they arrive in your inbox, 
or allow VIP alerts—and only VIP alerts—to light up your lock screen.

Mail’s VIP alerts give you separate notifications for your most important email 
contacts.
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Turn on alerts for Gmail’s Priority Inbox—and 
off for all your other inboxes (Android & iOS)
While iOS’s Mail app will let you pick and choose your VIPs, Gmail has 
its own secret formula for determining which messages are most 
important to you.

Using your prior emailing habits as a guide, Gmail’s Priority Inbox 
sifts through your incoming messages, finds the email that you’re 
most likely to answer, and puts them into an Important And Unread 
folder. Everything else (such as random email promos, newsletters, and 
other lower-priority messages) goes into the aptly named Everything 
Else section of your inbox.

Once that’s done, you can set Gmail to alert you only when new 
messages land in your Priority Inbox—and hopefully, you’ll feel better 
about leaving your silenced phone alone.

For Android:
First, you’ll need to enable Gmail’s Priority Inbox feature. Open Gmail, 
tap the menu button in the top left corner of the screen, tap Settings, 
pick a Gmail account, then tap Inbox Type → Priority Inbox.

Tap Manage Labels, then make sure that Priority Inbox is the only Gmail 
label with notifications turned on. (If you don’t see a Sound On, Notify 
Once or similar tag next to a label, then notifications are off for that label.)
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For iOS:
If you’re using Gmail for iOS, you’ll need to enable Priority Inbox from 
the desktop version of Gmail. Open Gmail in a desktop browser, click 
the Settings button, select Settings, click the Inbox tab, select Priority 
Inbox from the Inbox Type drop-down menu, then click Save Changes.

Go to the Gmail For iOS app, tap the menu button in the top left 
corner of the screen, tap the Settings button, choose the Important 
Only option under the Notifications heading, then tap Save.

Turn off unneeded lock-screen notifications 
(Android & iOS)

So, you’re in a meeting, your phone is sitting dutifully—and silently—
on the table in front of you, and you’re giving your colleagues your full 
attention. But then it happens: Your phone’s lock screen lights up, and 
your eyes can’t help but flick down to the display…which is nothing 
more than a random Facebook update.

Luckily, it’s easy to pare your lock-screen notifications down to an 
absolute minimum—or turn them off completely, even when you 
don’t have Do Not Disturb or Priority mode switched on.

It’s easy to 
pare your lock-
screen 
notifications 
down to an 
absolute 
minimum—or 
turn the option 
off completely.



HERE’S HOW



For Android:
To keep your phone’s lock screen from lighting up when notifications 
come in, tap Settings → Display, then toggle off the Ambient Display 
setting.

You can also completely turn off notifications for a specific app by 
tapping Settings → Sound & Notification → App Notifications, then tap 
an app and enable the Block setting. (Nope, you can’t only disable 
lock-screen alerts for a given app; it’s all or nothing.)

While you’re at it, you might also want to turn off your handset’s 
pulsing notification light—you know, the one that’s saying “Look at 
me, look at me!” all the time. Go back to Settings → Sound & 
Notification, then toggle on the Pulse Notification Light setting.

For iOS:
To completely turn off an app’s notifications, tap Settings → 
Notifications, tap an app, then toggle off the Allow Notifications 
switch.

If you only want to disable an app’s lock-screen notifications, leave 
the Allow Notifications switch on but turn off the Show On Lock 
Screen setting. 





EXCEL FUNCTIONS, OR formulas, lie at the heart of the application’s deep 
well of capabilities. Today we’ll tackle IF statements, a string of commands 
that determine whether a condition is met or not. Just like a yes-no 
question, if the specified condition is true, Excel returns one user-
determined value and, if false, it returns another.

The IF statement is also known as a logical formula: IF, then, else. If 
something is true, then do this, else/otherwise do that. For example, if it’s 
raining, then close the windows, else/otherwise leave the windows open.
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The syntax (or sentence structure; that is, the way the commands 
are organized in the formula) of an Excel IF statement is: =IF(logic_
test, value_if true, value_if_false). IF statements are used in all 
programming languages and, although the syntax may vary slightly, 
the function provides the same results.

Remember: Learning Excel functions/formulas and how they work 
are the first steps toward using Visual Basic, Microsoft’s event-driven 
programming language. Here are five easy IF statements to get you 
started.

Past-due notices
In this spreadsheet, the 
customer’s payment due 
date is listed in column A, 
the payment status is 
shown in column B, and 
the customer’s company 
name is in column C. The 
company accountant 
enters the date that each 
payment arrives, which 
generates this Excel 
spreadsheet. The 
bookkeeper enters a 
formula in column B that 
calculates which 
customers are more than 
30 days past due, then sends late notices accordingly.

A. Enter the formula: =TODAY() in cell A1, which displays as the 
current date.

B. Enter the formula: =IF(A4-TODAY()>30, "Past Due", 
"OK") in cell B4.

In English, this formula means: If the date in cell A4 minus today’s 
date is greater than 30 days, then enter the words Past Due in cell B4, 
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else/otherwise enter 
the word OK. Copy this 
formula from B4 to B5 
through B13.

Pass/Fail 
lifeguard test
The Oregon Lifeguard 
Certification is a Pass/
Fail test that requires 
participants to meet a 
minimum number of 
qualifications to pass. 
Scores of less than 70 
percent fail, and those 
scores greater than 
that, pass. Column A 
lists the participants’ 
names; column B shows their scores; and column C displays whether 
they passed or failed the course. The information in column C is 
attained by using an IF statement.

Once the formulas are entered, you can continue to reuse this 
spreadsheet forever. Just change the names at the beginning of each 
quarter, enter the new grades at the end of each quarter, and Excel 
calculates the results.

A. Enter this formula in cell C4: =IF(B4<70,"FAIL","PASS"). 
This means if the score in B4 is less than 70, then enter the word FAIL 
in cell B4, else/otherwise enter the word PASS. Copy this formula from 
C4 to C5 through C13.

Sales & bonus commissions
Wilcox Industries pays its sales staff a 10 percent commission for all 
sales greater than $10,000. Sales below this amount do not receive a 
bonus. The names of the sales staff are listed in column A. Enter each 
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person’s total monthly sales in column B. Column C multiplies the total 
sales by 10 percent, and column D displays the commission amount or 
the words No Bonus. Now you can add the eligible commissions in 
column D and find out how much money was paid out in bonuses for 
the month of August.

A. Enter this formula in cell C4: =SUM(B4*10%), then copy from C4 
to C5 through C13. This formula calculates 10 percent of each person’s 
sales.

B. Enter this formula in cell D4: =IF(B4>10000, C4, "No 
bonus"), then copy from D4 to D5 through D13. This formula copies 
the percentage from column C for sales greater than $10,000 or the 
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words No Bonus for sales less than $10,000 into column D.
C. Enter this formula in cell D15: =SUM(D4:D13). This formula sums 

the total bonus dollars for the current month.

Convert scores to grades with  
nested IF statements
This example uses a “nested” IF statement to convert the numerical 
Math scores to letter grades. The syntax for a nested IF statement is 
this: IF data is true, then do this; IF data is true, then do this; IF data is 
true, then do this; IF data is true, then do this; else/otherwise do that. 
You can nest up to seven IF functions.

The student’s names are listed in column A; numerical scores in 
Column B; and the letter grades in column C, which are calculated by a 
nested IF statement.
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A. Enter this formula in cell C4: =IF(B4>89,"A",IF(B4>79,"B"
,IF(B4>69,"C",IF(B4>59,"D","F")))), then copy from C4 to 
C5 through C13.

Note: Every open, left parenthesis in a formula must have a 
matching closed, right parenthesis. If your formula returns an error, 
count your parentheses.

Determine sliding scale sales commissions with 
nested IF statements
This last example uses another nested IF statement to calculate multiple 
commission percentages based on a sliding scale, then totals the 
commissions for the month. The syntax for a nested IF statement is this: 
IF data is true, then do this; IF data is true, then do this; IF data is true, 
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then do this; else/otherwise do that. The names of the sales staff are 
listed in column A; each person’s total monthly sales are in column B; and 
the commissions are in column C, which are calculated by a nested IF 
statement, then totaled at the bottom of that column (in cell C15).

A. Enter this formula in cell C4: =IF(B4<5000,B4*7%,IF(B4<80
00,B4*10%,IF(B4<10000,B4*12.5%,B4*15%))), then copy 
from C4 to C5 through C13.

B. Enter this formula in cell C15: =SUM(C4:C13). This formula sums 
the total commission dollars for the current month. 
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WE’VE TALKED ABOUT File Explorer (go.pcworld.com/w7file-explorer; 
Windows Explorer in Windows 7) several times before, and if you ask me it’s 
one of the most important parts of Windows to customize. Unlike a 
smartphone or tablet, you spend a lot of time diving into your PC’s file 
system and it’s worth it to get things organized just how you like it.

One good way to do that is to customize a folder’s column order—name, 

How to customize File 
Explorer’s details view in 
Windows
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size, type, date modified, and so on—under the details view. It’s really 
easy to organize columns in the order you’d like instead of just using 
the defaults. In fact, you can even apply a particular column order that 
you create to most other folders on your system.

I’ll be showing how it’s done in Windows 10, but it works similarly in 
Windows 7 and 8.

Sorting downloads
Let’s say you wanted to have the 
date show up first in the 
downloads folder. Just click on 
Date at the top of the column, 
and then drag it to the left. If you 
wanted to put the date column 
last, you’d do the reverse.

If you then wanted to sort 
everything by date, single-click 
on the Date column. Now all the 
files in the downloads folder will 
be sorted by date with the 
oldest items at the top. To reverse that order just click Date again.

This trick works for all columns.

Making a template
Now, let’s say you wanted to use a particular column setup from your 
downloads folder across all generic folders on your PC.

In Windows 10, click on This PC in the left-hand navigation column of 
File Explorer, then right-click on Downloads in the main window and 
select Properties from the context menu.

Click on the Customize tab and look under the first section, which 
reads Optimize This Folder For.

The drop-down menu you see there consists of five options that are 
the standard layout templates for File Explorer. By default in Windows 
10, the downloads folder uses the pictures template. Let’s change 

Moving 
columns is as 
easy as a drag-
and-drop.





that to General Items so that our downloads 
setup can affect most of our folders while 
leaving the standard Windows documents, 
music, and video folders untouched. You 
should also click the checkbox next to Also 
Apply This Template To All Subfolders.

If you’ve already customized your downloads 
folder, then changing to General Items will, 
unfortunately, return all column headings to 
the standard General Items template. Sort 
them again the way you like. For example, 
someone might prefer to see the filenames 
first, followed by file size, then file type, and 
finally the date.

Once it’s sorted, go to the File Explorer menu 
at the top and select View → Options → Change 
Folder And Search Options. Under the View tab click Apply To Folders. A 
pop-up window will appear asking you to confirm the change to all 

folders of the same type 
(General Items in this case). 
Click Yes, and all your generic 
folders should now default to 
your predefined structure.

You can even switch other 
folders to your template by 
simply changing the template 
for that folder under 
Properties → Customize.

To revert back to the 
standard layout for all folders, 
go back to View → Options → 
Change Folder And Search 
Options and under the View 
tab click Reset Folders. 

Windows 
offers five 
standard 
templates for 
organizing File 
Explorer.

This setting allows you to change similar 
folders on the same system with one click.





How to turn off Windows 
10’s keylogger
Microsoft can track your keystrokes, your speech, and more. 
Here are the settings to turn it all off.

J Confusion worries that, despite assumptions that it would be removed, 
the final version of Windows 10 still has a keylogger.

Last fall, I discussed the keylogger that Microsoft openly put into the 
Windows 10 Technical Preview. The company admitted that “we may 
collect voice information” and “typed characters.” At the time I 
defended Microsoft, pointing out that the Preview was “intended for 
testing, not day-to-day use,” and that Microsoft recommended against 
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installing the Preview on a computer with sensitive files. I said that “I 
seriously doubt that the worst spyware features will remain in the 
finished product.”

I was wrong.
Microsoft pretty much admits it has a keylogger in its Windows 10 

speech, inking, typing, and privacy FAQ: “When you interact with your 
Windows device by speaking, writing (handwriting), or typing, 
Microsoft collects speech, inking, and typing information—including 
information about your Calendar and People (also known as 
contacts)…”

If that feels creepy to you, welcome to the human race.
Speaking of online Microsoft documents, you may want to browse 

the company’s overall Privacy Statement. To Microsoft’s credit, it’s in 
plain English rather than legalese. On the other hand, it’s about 17,000 
words (as someone who’s paid by the word, I’m frankly jealous), so it 
will take time to find out if 
there’s anything else 
that’s truly awful inside.

The good news is that 
you can turn off the 
keylogging. Click Settings 
(it’s on the Start Menu’s 
left pane) to open the 
Settings program. You’ll 
find Privacy…ummm…
hold on a sec…OH! There 
it is!—on the very last row.

Once in Privacy, go to 
the General section and 
turn off “Send Microsoft 
info about how I write to 
help us improve typing and writing in the future.” While you’re there, 
examine the other options and consider if there’s anything else here 
that you may want to change.





Now go to the Speech, 
Inking, & Typing section 
and click Stop Getting To 
Know Me. (I really wanted 
to end that sentence 
with an exclamation 
point.)

You may also want to 
explore other options in 
Privacy. For instance, you 
can control which apps 
get access to your 
camera, microphone, 
contacts, and calendar. I 
wish I had that capability 
in Android. 

Have a tech question? Ask 
PCWorld Contributing 
Editor Lincoln Spector.  
Send your query to 
answer@pcworld.com
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Tech Spotlight
A video showcase of  

the latest trends  

» Okay, Internet of Things, you can stop now. Check out this $300 
electric razor that can track how often and how long you shave, and 
estimate how sensitive your skin is based on how much you use 
different components. You had no idea you needed this, did you? 
Neither did we. 

Seriously, a connected  
electric razor? Seriously?

Watch the  
video at

go.pcworld. 
com/razorvid




